Table of Contents

Introduction ........................................................................................................................................ 1
Instructor’s Guide Format .................................................................................................................. 1
System Requirements ....................................................................................................................... 2
  Graphic Cards ............................................................................................................................... 3
  Autodesk Inventor Software Installation Process ........................................................................... 4
Autodesk Inventor 6 Essentials Classroom Master Install Overview ........................................... 4
  Instructor Materials ..................................................................................................................... 4
  Student Courseware ..................................................................................................................... 5
  Using the Student Project File ..................................................................................................... 6
Who should use this guide? ............................................................................................................ 7
  Recommended Course Duration .................................................................................................. 7
  User Prerequisites ....................................................................................................................... 7
Autodesk Inventor 6 Essentials: Level I Course Description ........................................................... 8
Autodesk Inventor 6 Essentials: Level I Course Outline ................................................................. 10
Autodesk Inventor 6 Essentials: Level II Course Description ...................................................... 19
Autodesk Inventor 6 Essentials: Level II Course Outline ............................................................... 22
**Introduction**

Welcome to the *Autodesk Inventor 6 Essentials Classroom Master* which provides all the tools for delivering Level I or Level II Autodesk Inventor courses.

These tools include instructor guides, lecture presentations with speaker notes and instructor-led demonstrations with step-by-step instructions. Each chapter is organized around a specific function within Autodesk Inventor which allows you, as the instructor, to determine the specific topics you wish to cover in each chapter.

**Instructor’s Guide Format**

Each chapter in this guide is structured as follows to correspond to the Autodesk Inventor 6 Essentials courseware:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction to topic</strong></td>
<td>Presents a general overview of the topic.</td>
</tr>
<tr>
<td><strong>Objectives</strong></td>
<td>Lists what the students will do and learn.</td>
</tr>
<tr>
<td><strong>Notes to the Instructor</strong></td>
<td>Outlines the content of the modules, Lecture presentation powerpoints, instructor-led demos and Student Exercises.</td>
</tr>
<tr>
<td><strong>Student Exercises</strong></td>
<td>Presents the workflow for a specific tool or process, through illustrated step-by-step instructions. The complete set of student exercises is provided in electronic format.</td>
</tr>
<tr>
<td><strong>Additional References</strong></td>
<td>Student references to information in the Autodesk Inventor Design Support System (DSS), Autodesk Official Training Courseware (AOTC) and Visual Syllabus.</td>
</tr>
<tr>
<td><strong>Applying your skills</strong></td>
<td>Reviews skills and knowledge of the material covered in the chapter using challenge exercises. These exercises describe a design challenge, but do not provide step-by-step instructions.</td>
</tr>
<tr>
<td><strong>Checking your skills</strong></td>
<td>Tests students understanding of the material covered in the chapter using true / false or multiple-choice questions.</td>
</tr>
<tr>
<td><strong>Chapter Summary</strong></td>
<td>Summarizes in table format the tools and processes used in the chapter.</td>
</tr>
</tbody>
</table>
System Requirements

Autodesk Inventor can be installed on standalone workstations or a network.

The following sections review the basic hardware requirements. For detailed installation instructions, refer to the ReadMe file located on the product CD.

This section provides a list of all the system requirements.

- Microsoft Windows 2000 Professional (SP2 or better is required), Windows NT 4 (SP6 is required), Microsoft Windows XP Professional.
- Adobe Acrobat Reader
- Microsoft PowerPoint
- Microsoft Internet Explorer version 5.5 (or newer).
- Microsoft Excel (97 or newer).
- Microsoft NetMeeting 3.01 (or newer).
- 450 MB of free disk space for a minimal install of Autodesk Inventor only.
- 600 MB of free disk space for the installation of Autodesk Inventor (complete).

After installation, a workspace of 256 MB minimum is required on the drive pointed to by the user’s TEMP environment variable to run Autodesk Inventor. This location may be changed by running Autodesk Inventor and changing the location of the “Undo” file.

Processor and RAM

<table>
<thead>
<tr>
<th>Processor</th>
<th>Minimum</th>
<th>Recommended</th>
<th>Preferred</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Minimum hardware required to run. Not recommended for production use.</td>
<td>Small Assembly modeling (100 to 1000 parts)</td>
<td>Advanced Assembly modeling (1000 parts or greater)</td>
</tr>
<tr>
<td>Processor</td>
<td>Pentium III 450MHz or better*</td>
<td>Pentium III, Pentium 4, Xeon, 600MHz or better*</td>
<td>Pentium III, Pentium 4, Xeon, 1GHz or better*600 MHz or better</td>
</tr>
<tr>
<td></td>
<td>300 MHz or better</td>
<td>400 MHz or better</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB</td>
<td>512 MB</td>
<td>1 GB</td>
</tr>
</tbody>
</table>
Graphic Cards

There are many graphic card manufacturers. What do we recommend for a graphics card to give the best results with Autodesk Inventor?

- Autodesk Inventor requires OpenGL support, which is now a standard part of Windows. For best performance, we recommend a graphics card that supports OpenGL, with 16 MB video RAM or more. Your graphics card must be configured to support at least 32,768 colors, double-buffered display, and at least 15 bits of z-buffer and 1 bit of stencil buffer. Both PCI and AGP cards are supported.

  - If a card or driver does not meet these requirements, Autodesk Inventor runs using Microsoft software emulation of OpenGL.
  - Autodesk Inventor includes options to provide you with some control of hardware acceleration for graphics cards. This may be useful for Notebooks or unstable game cards. This is intended to be used if there is a problem with a card or driver. To access these options, navigate to Tools > Application Options, and then select the Hardware tab. Here are some further details about this new capability:

    - Autodesk Inventor now keeps certification information for many graphics card drivers. The driver rating (Green = certified, Yellow = certified but with limitations, Red = not certified) is shown on the Tools > Application Options > Hardware > Diagnostics dialog. You can set up Autodesk Inventor to warn you if the card is not certified in Tools > Application Options > Hardware. If you experience graphics problems, or want to download certified drivers, or want to know more about our certification criteria, check the Autodesk Inventor Web site at http://support.autodesk.com/inventor-graphic-cards.

    - Click OK in the Diagnostics dialog box to place a quantity of information on the Clipboard. This is not normally useful to you, but may assist Tech Support in diagnosing graphics issues.

Information on Graphic Cards

The latest Inventor graphics information is posted on the following sites:

- http://support.autodesk.com/inventor-graphic-cards
- http://autodesk.com/inventor
Autodesk Inventor Software Installation Process

To install the software:

- Insert the Autodesk Inventor 6 CD-ROM in your computer's CD-ROM drive. The Setup Wizard starts automatically.
- For installation instructions, please read the ReadMe file located on your Autodesk Inventor 6 product CD.

*Note: If the wizard does not start, select Start > Settings > Control Panel > Add/Remove Programs, click Install, and then browse for the CD-ROM.*

Autodesk Inventor 6 Essentials Classroom Master Install Overview

The *Autodesk Inventor 6 Essentials Classroom Master* Install includes materials for the instructor and the student and places two shortcuts on your machine. Instructors use the *Autodesk Inventor 6 Essentials Instructor Resources* shortcut to review and print the instructor’s related documents. Students use the *Autodesk Inventor 6 Essentials Exercises* shortcut to start the *Autodesk Inventor 6 Essentials* electronic student workbook.

*Note: The Readme.doc file on the Autodesk Inventor 6 Essentials Classroom Master CD-ROM contains instructions on how to install this courseware to multiple systems on a network.*

Folder Structure

The installation procedure places all the instructor and student materials required for this course into an *Essentials Classroom Master* folder on your system. By default, the *Essentials Classroom Master* folder is created in the *C:\Program Files* folder.

Instructor Materials

This classroom master is designed for instructors who want to deliver a Level I or Level II Autodesk Inventor 6 course. The content for each course is designed to accommodate the instructor who delivers Autodesk Inventor in a traditional lecture/lab format, where the instructor takes an active part in student learning.

The instructor materials for both courses are located in an *Instructor Resources* folder directly under the *Essentials Classroom Master* folder. The instructor materials include a detailed instructor guide, complete with course outline, learning objectives, instructor preparation lists, and snapshots of the lecture presentations with speaker notes and tips. In addition, instructor-led demonstrations are provided with complete step-by-step instructions. A
printable version of the student courseware is also available from the instructor resources tool. To access the instructor resources, use the Autodesk Inventor 6 Essentials Instructor Resources shortcut on your desktop.

**Note:** For your convenience, we have provided the course outline in Microsoft Excel format so that you can adjust the outline to your needs. This file is located in the Instructor Resources folder.

The Instructor Demos folder is located in the Essentials Classroom Master folder and contains all the datasets for the instructor-led, step-by-step demonstrations. This folder also includes an Autodesk Inventor Project file for the Instructor. The file is called Essentials_Instructor_Demos.ipj. The following section provides instructions on how to use this project file.

**Using the Instructor Demos Project File**

Before you start using the instructor demonstrations, complete these steps:

1. Start Autodesk Inventor.
2. In What to Do, click Projects.

**Note:** If you are already in Autodesk Inventor, close all files.

3. Click Browse, and then navigate to the Essentials Classroom Master/Instructor Demos folder.

4. Select Essentials_Instructor_Demos.ipj, and then click Open.

5. Double-click Essentials_Instructor_Demos to make the project active.

6. Click Cancel to close the dialog box.

This project file will manage the location of the instructor demonstration files and new files you create.

**Student Courseware**

Both Level I and Level II courses reference the Autodesk Inventor 6 Essentials courseware. The Autodesk Inventor 6 Essentials courseware includes a manual that provides instruction for how to use key tools and processes in Autodesk Inventor. This courseware also includes an electronic student workbook that contains all the Autodesk Inventor 6 Essentials exercises.

The manual is provided in electronic format (.pdf) and is accessible from the Instructor Resources tool. You can also order manuals individually for your students by visiting The Source at: www.autodesksource.com.

The Autodesk Inventor 6 Essentials Exercises shortcut starts the Autodesk Inventor 6 Essentials Exercises. This electronic student workbook contains all
the real-world, step-by-step exercises referenced in the Autodesk Inventor 6 Essentials manual. All the Autodesk Inventor datasets required for the exercises are located in the Essentials Classroom Master folder.

**Using the Student Courseware**

1. Double-click the Autodesk Inventor 6 Essentials Exercises shortcut on your desktop to display the main page.

2. Review the Introduction for information on using the courseware and setting up the correct project file in Autodesk Inventor.

*Note:* The automated exercise steps in the courseware will not function properly unless you follow the instructions provided in the Introduction section of the courseware.

**Using the Student Project File**

Most engineers work on one or more projects at a time. To accommodate this, Autodesk Inventor uses projects to organize related files and maintain links between files. Each project has a project file that stores the paths to all the files related to the project. When you attempt to open a file, Autodesk Inventor uses paths in the current project file to locate other necessary files. To work on a different project, you must make the appropriate project active.

Before the students start the exercises, complete these steps:

1. Start Autodesk Inventor.

2. In What to Do, click Projects.

*Note:* If you are already in Autodesk Inventor, close all files.

3. Click Browse, and then navigate to the ..\Essentials Classroom Master folder.

4. Select Essentials_Exercises.ipj, and then click Open.

5. In the Projects window, double-click Essentials_Exercises to activate it.

6. Click Cancel to close the dialog box.

The project file will manage the location of existing files and files you create.

*Note:* The instructor demo files are located in a different folder. The Essentials Instructor Demos project file is used to manage those files. Refer to the Introduction in this guide for instructions.
Who should use this guide?

This classroom master is designed for instructors who want to deliver a Level I or Level II Autodesk Inventor 6 course. The Level I course covers basic Autodesk Inventor sketching, part and assembly modeling, and drawing creation skills. The Level II course covers more complex Autodesk Inventor topics.

The content for each course is designed to accommodate the instructor who delivers Autodesk Inventor in a traditional lecture/lab format, where the instructor takes an active part in student learning.

Recommended Course Duration

The course guide is designed to accommodate a two- and three-day training course. The number of hours allocated to each topic is an approximation based on a topic discussion, demonstration and time to complete the exercises in the electronic student workbook.

In addition to these hours, there are other exercises and tutorials available that can be used to complement the recommended material.

User Prerequisites

It is recommended that students have a working knowledge of Microsoft® Windows® 98 SE, Windows 2000 Professional, or Windows NT® 4.0.
**Autodesk Inventor 6 Essentials: Level I Course Description**

<table>
<thead>
<tr>
<th>Course Name</th>
<th>Autodesk Inventor 6 Essentials: Level I</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Who Should Attend</strong></td>
<td>New Autodesk Inventor customers, 2D Drafters wanting to learn basic 3D design techniques, resellers who intend to teach this course, new reseller technical staff.</td>
</tr>
<tr>
<td><strong>Course Description</strong></td>
<td>This course is designed to enable attendees to understand the basics of Mechanical Computer-aided Design (MCAD) using Autodesk Inventor. Attendees will learn how to navigate the gesture-based user interface, and receive overviews of the basic sketching, part modeling, and assembly modeling techniques. The course also includes a general review of the tools for creating mechanical drawings.</td>
</tr>
<tr>
<td><strong>Objectives</strong></td>
<td>After attending this two-day course, attendees should be able to:</td>
</tr>
<tr>
<td></td>
<td>Create and Modify Parametric Parts, including:</td>
</tr>
<tr>
<td></td>
<td>• Creating, Constraining, Dimensioning and Modifying Sketches</td>
</tr>
<tr>
<td></td>
<td>• Creating and Editing Simple Sketched Features</td>
</tr>
<tr>
<td></td>
<td>• Creating and Editing Placed Features, including Fillets, Chamfers, Holes, Threads, Feature Patterns, Shells and Face Drafts</td>
</tr>
<tr>
<td></td>
<td>• Creating and Editing Work Features</td>
</tr>
<tr>
<td></td>
<td>Create and Manage Assemblies, including:</td>
</tr>
<tr>
<td></td>
<td>• Placing, Moving and Constraining Components</td>
</tr>
<tr>
<td></td>
<td>• Creating Components in the Context of an Assembly</td>
</tr>
<tr>
<td></td>
<td>• Creating Parts that Adapt to Other Parts in an Assembly</td>
</tr>
<tr>
<td></td>
<td>• Placing Standard Parts using the Content Library</td>
</tr>
<tr>
<td></td>
<td>• Using the Browser to Reorder and Restructure Components</td>
</tr>
<tr>
<td></td>
<td>• Creating and Modifying Component Patterns</td>
</tr>
<tr>
<td></td>
<td>• Simulating and Analyzing Mechanisms</td>
</tr>
</tbody>
</table>
Document Parts and Assemblies, including:
- Using Standard Formats, Styles, Drawing Resources, and Formats
- Creating and Editing Standard Base, and Projected Views
- Annotating Drawings with Dimensions, Centerlines, Hole Tables, Symbols, Parts Lists and Balloons

<table>
<thead>
<tr>
<th>Methods</th>
<th>Lecture and hands-on instructor-led Classroom Training</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The instructor will deliver lectures with PowerPoint</td>
</tr>
<tr>
<td></td>
<td>presentations, demonstrations and hands-on exercises</td>
</tr>
<tr>
<td></td>
<td>to teach attendees how create simple parts, simple</td>
</tr>
<tr>
<td></td>
<td>assemblies, presentations and drawings using Autodesk</td>
</tr>
<tr>
<td></td>
<td>Inventor.</td>
</tr>
</tbody>
</table>

| Prerequisites            | None – this class is accessible as an introduction to  |
|                         | Computer-Aided Design (CAD)                             |

| Duration                | 2 days                                                 |
## Autodesk Inventor 6 Essentials: Level I Course Outline

### Day One

**Topic: Getting Started**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topics</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Welcome and introductions</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Review course objectives for Chapter One</td>
<td>1</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>How to use projects</td>
<td>1</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Exercise 1-1: Projects</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>File types</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Application options</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Design Support System</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>User Interface</td>
<td>1</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Exercise 1-2: Viewing a Model</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Summary of the chapter</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Review answers to Checking Your Skills questions at end of Chapter One in Autodesk Inventor 6 Essentials</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>2</td>
<td>23</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: How to sketch, constrain and use dimensions

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topics</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Introduce how to sketch, constrain and dimension</td>
<td>1.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Review course objectives for Chapter Two</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sketching and part applications options</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Units</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Templates</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Creating a part</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sketches overview</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Exercise 2-1: Creating a sketch with lines</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Exercise 2-2: Creating a sketch with tangencies</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Constraining the sketch</td>
<td>1.5</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Exercise 2-3: Adding and displaying constraints</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Adding Dimensions</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Exercise 2-4: Dimensioning a sketch</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Summary of the chapter</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Applying Your Skills: Exercises 2-1, 2-2</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>3</td>
<td>24</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: How to create and edit sketches

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topics</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Introduce how to create and edit sketches</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Describing features</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Features and how to use the Browser</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Switching environments</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Extruding a sketch</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Exercise 3-1: Extruding a sketch</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Revolving a sketch</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Exercise 3-2: Revolving a sketch</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Editing a feature</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Exercise 3-3: Editing features and sketches</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Sketched features and defining active sketch plane</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Exercise 3-4: sketch planes</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Projecting part edges</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Instructor-led demo for 2D sketching projecting loops</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>3</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Applying Your Skills: Exercises 3-1, 3-2, 3-3</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

Total: 3 hours, 28 PowerPoint slides
# Day Two

## Topic: How to create placed features

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Introduce how to create placed features</td>
<td>0.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Fillets and chamfers</td>
<td>4</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-1: Creating fillets and chamfers</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Holes</td>
<td>4</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-2: Creating holes</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Threads</td>
<td>3</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-3: Creating threads</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Shelling</td>
<td>0.5</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-4: Shelling a part</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Face Draft</td>
<td>2</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-5: Creating face drafts</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Work features</td>
<td>0.5</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-6: Creating work axes</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Work planes</td>
<td>2</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-7: Creating work planes</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Patterns</td>
<td>0.5</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Instructor-led demo: Pattern along a path</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-8: Creating rectangular patterns</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-9: Creating circular patterns</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Exercise 4-10: Creating path patterns</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Review Summary</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applying Your Skills: Exercises 4-1, 4-2</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>2</td>
<td>41</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: How to create and edit drawing views

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Introduce how to create and edit drawing views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Two-dimensional 2D drawing views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Drawing options</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Creating a drawing, borders and title blocks</td>
<td>4</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Exercise 5-1: Sheets, borders and title blocks</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Setting up drafting and dimension standards</td>
<td>2</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Drafting standards</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Dimension styles, templates</td>
<td>2</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Creating drawing views</td>
<td>1</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Exercise 5-2: Creating multi-view drawing</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Editing drawing views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Exercise 5-3: Editing drawing views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Dimensions and annotations</td>
<td>1</td>
<td>5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Holes and Thread Notes</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Exercise 5-4: Creating text and dimension styles</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Exercise 5-5: Adding dimensions and annotations</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Review summary</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applying Your Skills: Exercise 5-1, 5-2</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>3</td>
<td>30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: How to create and document assemblies

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Introduce how to create and document assemblies</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Review chapter objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Creating assemblies</td>
<td></td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Assembly constraints</td>
<td></td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-1: Assembly constraints</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Designing parts in place</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-2: Designing parts in the assembly context</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Adaptivity</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-3: Creating adaptive parts</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Analysis tools</td>
<td></td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: center line of gravity</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-4: Analyzing assemblies</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Presentation files</td>
<td>1</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-5: Presentation views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Creating drawing view from assemblies and presentation files</td>
<td></td>
<td>9</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Exercise 6-6: Presentation views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Review summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Applying Your Skills: Exercises 6-1, 6-2</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------------------------</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>3</td>
<td>69</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Autodesk Inventor 6 Essentials: Level II Course Description

<table>
<thead>
<tr>
<th>Course Name</th>
<th>Autodesk Inventor 6 Essentials: Level II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who Should Attend</td>
<td>New Autodesk Inventor customers, 2D drafters wanting to learn 3D design techniques, resellers who intend to teach this course, new reseller technical staff.</td>
</tr>
<tr>
<td>Course Description</td>
<td>This course is designed to provide attendees with a thorough coverage of 3D Mechanical Computer-aided Design (MCAD) techniques using Autodesk Inventor 6. Attendees explore complex sketching and constraining techniques, complex part and assembly modeling techniques, surface modeling, sheet metal design, creating weldments, design automation techniques, and advanced design data migration techniques.</td>
</tr>
<tr>
<td>Objectives</td>
<td>After attending this three-day course, attendees should be able to:</td>
</tr>
<tr>
<td></td>
<td>Apply Complex Sketching Techniques, including:</td>
</tr>
<tr>
<td></td>
<td>• Creating and Constraining Construction Geometry and Splines</td>
</tr>
<tr>
<td></td>
<td>• Sharing and Mirroring Sketches</td>
</tr>
<tr>
<td></td>
<td>• Defining and Using Part Dimensional Tolerances and Equations</td>
</tr>
<tr>
<td></td>
<td>Apply Complex Part Modeling Techniques, including:</td>
</tr>
<tr>
<td></td>
<td>• Creating and Using Open Profiles and 3D Sketches</td>
</tr>
<tr>
<td></td>
<td>• Creating Rib, Emboss and Coil Features</td>
</tr>
<tr>
<td></td>
<td>• Creating Complex Sweeps, Lofts and Extrusion Features</td>
</tr>
<tr>
<td></td>
<td>• Suppressing, Reordering, and Mirroring Features</td>
</tr>
<tr>
<td></td>
<td>• Applying Face Colors, Decals, and Textures to Parts</td>
</tr>
<tr>
<td></td>
<td>Apply Complex Assembly Modeling Techniques, including:</td>
</tr>
<tr>
<td></td>
<td>• Using iMates, Motion and Transitional Constraints</td>
</tr>
<tr>
<td></td>
<td>• Using the Content Library and Replacing Components</td>
</tr>
<tr>
<td></td>
<td>• Creating and Using Component Patterns</td>
</tr>
<tr>
<td></td>
<td>• Creating and Using Assembly Features and Adaptive Design Techniques</td>
</tr>
</tbody>
</table>
Create and Edit Complex Drawing Views, including:

- Creating Auxiliary, Section, Detail, Broken, Breakout Section, and Draft Views
- Creating and Using Sketched Symbols, Hole and Thread Notes, Parts Lists, Revision Blocks, and other Annotations
- Creating and Using Dual, Auto Baseline, and Ordinate Dimensions

Apply Surface Modeling Techniques, including:

- Creating and Using Construction Surfaces
- Creating and Using Model Surfaces

Create and Manage Sheet Metal Designs, including:

- Managing Sheet Metal Styles
- Creating Sheet Metal Features (Bends, Flanges, Hems, Corner Seams, Cuts, and the Punch Tool)
- Creating Flat Patterns and Sheet Metal Drawings

Create and Manage Weldments, including:

- Weldment Preparation
- Creating Weld Beads
- Creating Machining Operations/Post-Processing
- Creating Weldments Drawings

Automate Part and Assembly Modeling Design Techniques, including:

- Creating and Managing iFeatures
- Creating and Managing iPart Factories
- Creating and Using Derived Components

Apply Collaborative Design Techniques, including:

- Using the Engineer’s Notebook
- Learning how to Design in a Multi-User Environment
- Using the Design Assistant to Manage Designs
<table>
<thead>
<tr>
<th>Methods</th>
<th>Lecture and hands-on instructor-led Classroom Training</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The instructor will deliver lectures with PowerPoint presentations, demonstrations and hands-on exercises to teach attendees how use Autodesk Inventor to create and manage standard and sheet metal parts, create assemblies and weldments, create presentations and drawings.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Autodesk Inventor 6 Essentials Level I course</td>
</tr>
<tr>
<td>Duration</td>
<td>3 days</td>
</tr>
</tbody>
</table>
### Autodesk Inventor 6 Essentials: Level II Course Outline

#### Day One

**Topic:** Complex sketching and constraining techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Welcome, introductions and review course objectives for Level II</td>
<td>1</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Review course objectives for Chapter Seven: Complex sketching and constraining techniques</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Construction geometry and ellipses</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2D splines and options</td>
<td>5</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: 2D sketching-spline controls</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: 2D sketching-offset splines and ellipses</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Exercise 7-1: Complex Sketching</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pattern sketches</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Shared sketches</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Mirror sketches</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Slice graphics</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Project edges</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sketch on another part's face</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Exercise 7-2: Projecting edges and sketching on another part's face</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Auto dimension</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Dimension display, relationships, equations</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Parameters and user parameters</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linked parameters</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>------------------</td>
<td>---</td>
<td>-------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Part dimensional tolerances</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Standard tolerances</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Override tolerances</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Tolerances</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Exercise 7-3: Auto dimension, relationships and parameters</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Summary of the chapter</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Applying Your Skills: Exercise 7-1</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>3</td>
<td>39</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Topic: Complex part modeling techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Introduce complex part modeling techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Review chapter objectives</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Using open profiles</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Rib and web features</td>
<td>4</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-1: Creating ribs and webs</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Extrude feature termination options</td>
<td>2</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Emboss text features</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: emboss</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-2: Creating text and emboss features</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sweep features</td>
<td>1</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-3: Creating sweep features</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Coil features</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Loft features</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: loft control</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(2) Instructor-led demo: using guide rails</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-4: Creating loft features</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Part split and face split</td>
<td>2</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-5: Splitting a part</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Copying, reordering and mirroring features</td>
<td>1</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Suppressing features and feature rollback</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>File properties</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>-----</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Center of gravity</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Override mass and volume properties</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Visualization</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exercise 8-6: Visualization</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Review Summary</td>
<td>2</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Applying Your Skills: Exercise 8-1</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>3</td>
<td>54</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: Complex drawing view creation and editing

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Introduce complex drawing view creation and editing</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review chapter objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Creating complex drawing views</td>
<td></td>
<td>11</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Drawing view options</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-1: Complex drawing view techniques</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Managing sheets</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Dimensioning drawing views</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: hole tables</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-2: Dimensioning drawing views</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Sketched objects</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Additional drawing tools</td>
<td></td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-3: Annotations</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Applying Your Skills: Exercise 9-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>Total</strong></td>
<td><strong>2</strong></td>
<td><strong>46</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Day Two

### Topic: Complex assembly modeling

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Introduce complex assembly modeling</td>
<td>1.5</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Design views</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Assembly Browser</td>
<td></td>
<td>6</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>iMates</td>
<td></td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-1: Creating and using iMates</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Driving constraints</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-2: Driving constraints</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Constraint tools</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Replacing components</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Standard Parts Library</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-3: Fasteners and parts library</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Patterning components</td>
<td></td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-4: Patterning components</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Assembly features</td>
<td>2.5</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-5: Assembly features</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2D design layout</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-6: 2D design layout</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Adaptive design techniques</td>
<td></td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-7: Adaptive design techniques</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Applying Your Skills: Exercise 10-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------------------------</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>5</td>
<td>70</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Topic: Sheet metal design

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Introduce sheet metal design</td>
<td>1.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Review chapter eleven objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal fabrication</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal parts</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-1: Sheet Metal part I</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-2: Creating Hems</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td></td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-3: Modifying sheet metal parts</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-4: Cut across bend</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-5: Corner seams from shelled solids</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-6: Punch tool</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Detailing sheet metal designs</td>
<td>0.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-7: Documenting sheet metal designs</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Applying Your Skills: Exercise 11-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td>3</td>
<td>34</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Day Three

**Topic: Surface modeling**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Introduce surface modeling</td>
<td>0.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Review chapter twelve objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Creating surfaces</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Exercise 12-1: Importing surfaces</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Using surfaces</td>
<td>1</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Exercise 12-2: Using surfaces</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Face Analysis using display styles</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Instructor-led demo: analyze draft (color)</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Instructor-led demo: analyze draft (zebra)</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Review Summary</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Applying Your Skills: Exercise 12-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td><strong>1.5</strong></td>
<td><strong>24</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: Weldments

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Introduce weldments</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Review chapter thirteen objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Welding basics</td>
<td>36</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Exercise 13-1: Creating weld beads and machining weldments</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Documenting weldments</td>
<td>0.5</td>
<td>11</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Exercise 13-2: Documenting weldments</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Applying Your Skills: Exercise 13-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td><strong>1.5</strong></td>
<td><strong>53</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Topic: Design automation techniques**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Introduce Design automation techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Review chapter fourteen objectives</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>iParts</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Creating iParts</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Editing iParts</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Creating iParts (additional author dialog)</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-1: Creating and placing iParts</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>iFeatures</td>
<td>11</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-2: Creating and placing iFeatures</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Derived parts</td>
<td>3</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-3: Creating a derived part</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Derived assemblies</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Customization</td>
<td>4</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Review Summary</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Applying Your Skills: Exercises 14-1, 14-2</td>
<td>1</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>14</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td>2</td>
<td>42</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Topic: Collaboration techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Introduce collaboration techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review chapter fifteen objectives</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Engineer's notebook</td>
<td>7</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Multi-user environment</td>
<td>12</td>
<td>12</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>File Versions</td>
<td>1</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: file versions</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercises 15-1: File Versions</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Design Assistant</td>
<td>1</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-2: Using Design Assistant</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Online collaboration tools (Streamline, Team Web)</td>
<td>1</td>
<td>17</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Migrating Files</td>
<td>1</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exchanging Model Data</td>
<td>1</td>
<td>13</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-3: Importing a DWG file</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Importing other file types</td>
<td>5</td>
<td>5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-4: Importing IGES and STEP files</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-5: Base solids</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review Summary</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Applying Your Skills: Exercises 15-1 and 15-2</td>
<td>2</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>3</strong></td>
<td><strong>76</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Chapter Seven: Complex Sketching and Constraining Techniques

## Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

## Day 1

**Topic:** Complex sketching and constraining techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Welcome, make introductions and review objectives for the Level II course</td>
<td>1</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Review course objectives for Chapter Seven: Complex sketching and constraining techniques</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Construction geometry and ellipses</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2D splines and options</td>
<td>5</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: 2D sketching-spline controls</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: 2D sketching-offset splines and ellipses</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Exercise 7-1: Complex Sketching</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pattern sketches</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Shared sketches</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Mirror sketches</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Slice graphics</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Project edges</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Sketch on another part’s face</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Exercise 7-2: Projecting edges and sketching on another part’s face</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------------------------------------------------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Auto dimension</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Dimension display, relationships, equations</td>
<td>2</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Parameters and user parameters</td>
<td>3</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Linked parameters</td>
<td>2</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Part dimensional tolerances</td>
<td>2</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Standard tolerances</td>
<td>3</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Override tolerances</td>
<td>2</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Tolerances</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Exercise 7-3: Auto dimension, relationships and parameters</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Summary of the chapter</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Applying Your Skills: Exercise 7-1</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>3</td>
<td>37</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Welcome and Introductions

Trainer Note: Welcome everyone to class and ask them to make introductions.

Level II Course Objectives

- Create Parts and Assemblies Using Complex Sketching, Part Modeling, and Assembly Modeling Techniques
- Create and Document Sheet Metal Parts and Weldments
- Create, Edit, and Annotate Complex Drawing Views
- Automate Part and Assembly Modeling Design Techniques
- Improve Design Efficiency Using Collaborative Design Techniques

Trainer Note: Review the Level II course objectives and return them at the completion of the course to reinforce what was covered during the training.
Slide 1

Autodesk Inventor 6
Complex Sketching and Constraining Techniques

Slide 2

Objectives

- Chapter Objectives
  - Use construction geometry to help constrain sketches
  - Create and constrain an ellipse
  - Create a 2D spline and a pattern of sketch geometry
  - Share a sketch
  - Utilize both the symmetry constraint and mirror tool
  - Slice the graphics screen
  - Sketch on another part's face
  - Create dimensions using the automatic dimensioning tool
  - Change the display of dimensions
  - Create relationships between dimensions
  - Create parameters and parts from Microsoft Excel
  - Create parts with dimensional tolerances

Trainer Note: Review the course objectives which correspond to the material in Chapter 7 of the Essentials 6 manual.
Slide 3

Complex Sketching and Constraining Techniques

Construction Geometry and Ellipses
Slide 4

**Construction Geometry**

- **Construction Geometry**
  - Reduce the number of constraints and dimensions that are required to fully constrain a sketch
  - Example...
    - circle inside a hexagon can drive the size of the hexagon
  - Can be constrained and dimensioned
  - Not be seen in the part
  - Editing
  - Line style
  - Color of the image

**Technical Note**

There is no construction line type in drawing sketches.
**Ellipses**
- Can be trimmed, extended, and dimensioned
- Offset
  - Concentric ellipse
  - Spline profile
  - Major or minor axis

**Technical Note**
For dimensioning, ellipses are divided into zones. Each zone is a 90 degree section of the ellipse. Depending on where you select the ellipse, you will get either the half-major or half-minor dimension.

A true offset ellipse is a spline. A concentric ellipse can be constructed by dragging one of the axes. If you offset an ellipse inward, you will see that the minimum size is limited. When the spline goes from a curve to a point on the major axis, you can’t make it any smaller. A concentric ellipse will continue to shrink until it is almost a line.
Complex Sketching and Constraining Techniques

2D Splines

- Create complex shapes
- Free flowing shapes
- Points
- Edited and Controlled
- Spline options
Technical Note
The spline controls are additive. The handle is the basic control. The next control is curvature. When curvature is active, handle is also on. If flat is selected, then both handle and curvature are also selected.

The handle controls the direction and the distance that the curve remains tangent to the handle at that point. As you move the handle, the curvature line updates.

The curvature controls the rate of change of the spline at that point. The flat changes the curvature to a straight line. This makes the spline straight for a greater distance.
Technical Note

- There are different methods for creating a spline that go through a series of points. The terms Smooth and Sweet were used rather than names of the mathematical models. A smooth curve is curvature continuous (that means that the radius of curvature is constantly changing). All three methods produce a continuous curve. A sweet curve will have better reflection lines because the radius of curvature doesn’t change as quickly.
- The AutoCAD method is used in ACAD, MDT, and the original Inventor splines.
- The Smooth method uses a centripetal solve. It is characterized by the curve overshooting the point.
- The Sweet method uses an energy solve. Although a nice curve is produced by this method, it is more computationally intensive. Using the sweet method will impact performance when surfaces are created.
Technical Note

- You can add a point to a spline by clicking Insert Point and then clicking on the spline. A Shape Point is added to the spline and the spline recalculates. There are two types of spline points- Fit points and Shape points. The spline is required to go through a fit point, but a shape point might be moved slightly during the solve in order to produce a better curve. The end points of a spline are always fit points. Interior points are usually shape points. A shape point becomes a fit point when it is completely constrained (dimensioned or constrained to other geometry).

- Close spline will extend the spline from the end point to the start point. If you deselect Close Spline, a new end point is created at the start point. The user can drag that point to a new location or right-click on it and select Delete. The spline will then revert back to the previous end point.

- The curvature comb gives a graphical display of the radius of curvature. The smaller the radius, the longer the line.
Technical Note

- The spline tension works like a fan belt on a car. With low tension, the belt has big curves. As the belt is tightened, the belt has straight lines between the pulleys.

- The handles can be dimensioned and constrained. The parallel constraint on the handle defines the tangency of the spline at the fit point. The linear dimension is used to fix the length of the handle. Since the spline contour is dependent on the handle length and orientation, the curvature control and the location of adjacent points, the handle dimension is not meaningful. You could have the same dimension on each handle of the spline, and the shape could be different at each point.

- The curvature control defines the instantaneous radius of the spline at the fit point. The radius changes continuously, so the curvature dimension is only valid at the point.
Instructor-led demo for 2D sketching-spline controls

1. Open a new part file.
2. Click Spline and create a spline with approximately six control points
3. Right-click the curve and discuss the new controls – Bowtie and Spline Tension
4. Review Display Curvature
5. Right-click a control point to display the reduced options in the menu
6. Select Bowtie > Handle and review how you can control the spline
7. First, add a horizontal or vertical constraint to the handle
8. Second, dimension the handle, then edit the dimension
9. Right-click the same control point
10. Select Bowtie > Curvature and review how you can control the spline
11. First, drag a curvature handle to change the spline
12. Second, dimension the curve, then edit the dimension
13. Right-click the same control point
14. Select Bowtie > Flat and review how you can control the spline
15. The spline is flat at the control point relative to the length of the handlebar
16. Close the file, do not save any changes

End of demonstration.
Instructor-led demo for 2D sketching-offset spline and ellipse

1. Open a new part file
2. Click Spline and create a spline with approximately six control points
3. Click Offset, then offset the curve
4. Right-click then select Done
5. Drag constrain the original spline to display how the offset spline behaves
6. Click General Dimension, then add a dimension between the two curves
7. Right-click the offset spline, then select Convert to Spline. The dimension is removed and a new spline is created
8. Open a new part file
9. Click Ellipse and create an ellipse
10. Click Offset, then hover the cursor near an ellipse quadrant to display an axis, and create an offset ellipse
11. Create a second offset ellipse making sure that the axis is not displayed
12. Drag the original ellipse to display the behavior of the two offset ellipse
13. Click General Dimension, then add a dimension between the original ellipse and the second offset ellipse. The offset ellipse should be selected first
14. Exit the General Dimension tool, then drag the dimension around the sketch to display that the distance is equidistant
15. Close the file, do not save any changes

End of demonstration
Slide 12

Exercise 7-1

* Complex Sketching

Slide 13

Complex Sketching and Constraining Techniques

Pattern, Shared and Mirror - Sketches
Pattern Sketches

Pattern Sketches
- Instead of creating multiple sketches
- Rectangular or Polar
- Occurrences or Elements
- Rectangular & Circular Pattern dialog box
  - Suppress
  - Associative
  - Fitted
- Occurrences or Elements

Technical Note

Suppressed geometry is changed to a dashed line. This allows the pattern to maintain its integrity without the suppressed entities participating in profile selection. In drawings, suppressed sketch pattern geometry is changed to the Sketch Only style so it doesn't display after the sketch is exited. You can suppress occurrences of a sketch pattern, but not the individual entities. If you don't want some entities in a particular instance, select the entity(s) and change the line style to construction.
Shared Sketches

- **Shared Sketches**
  - Copy of the original sketch
  - Same sketch geometry, dimensions & face
  - Same name
  - Update
  - On limit

**Technical Note**

A shared sketch IS the original sketch, it just shows up in multiple places in the browser.
Mirror Sketches

- Mirror Sketches
  - Create a symmetrical part
  - Symmetry constraint
    - Reduce the number of constraints and dimensions
    - Changes - updates
    - Automatically
    - Manually
      - same object type
      - lie on opposite sides of a line

Exercise 7-2

- Patterning, Sharing and Mirroring Sketches
Complex Sketching and Constraining Techniques

Slice Graphics, Project Edges and Sketch on another Part's Face
Technical Note
The sliced graphics texture can cause performance issues on some machines. Go to Tools>Application Options>Colors and deselect Show Reflections and Textures. This will turn off display of reflections and color styles that use textures.
Slide 20

**Technical Note**

- Project loop is new for R6.
- Projected cut edges are not associative.
- Automatic project edges on sketch creation. This is the default setting. It can produce a lot of extra reference edges on complex parts.
- Project Flat Pattern will project all of the intermediate faces between the selected face and the face that the sketch is attached to.
Slide 21

**Sketch on another Part's Face**

- Sketch
  - Can be placed on a face or plane of another part
  - Not limited to first sketch
  - Associated
  - Adaptive

Slide 22

**Exercise 7-3**

- Projecting Edges and Sketching On Another Part's Face
Slide 23

Complex Sketching and Constraining Techniques

Auto Dimension, Dimension - Display, Relationships and Equations

Slide 24

Auto Dimension

- **Auto Dimension**
  - Time-consuming
    - Adding or Removing constraints and dimensions
  - Apply critical constraints and dimensions
  - Will not override or replace any existing
Slide 25

### Dimension Display

- **Dimensional Relationships**
  - Set up relationships between dimensions

- **Dimension Display**
  - **Automatically tagged - label**
    - “d” and a number (d9, d27)
  - **Five options**
    - Display as Value
    - Display as Name
    - Display as Expression
    - Display as Tolerance
    - Display Precise Value

- **Change dimension display style**

Slide 26

### Dimension Relationships

- **Dimension Relationships**
  - Setting relationship between creating and existing dimensions
  - Edit Dimension dialog box
    - Dimensions label (d8)
Slide 27

Dimension Equations

- Dimension Equations
  - Can be used whenever a value is required
- Example:
  - (d/4)^2, or 50 mm + 19 mm
  - prefixes, precedence, operators, functions, syntax, and units
- Help system
- Invalid expression
  - Red

Slide 28

Complex Sketching and Constraining Techniques

Parameters
Slide 29

Parameters

- Parameters
  - User-defined name assigned a numeric value, either explicitly or through equations
  - Multiple parameters
    depth = length – width
  - Anywhere a value is required
  - Three types
    - model parameters
    - user parameters
    - linked parameters

Slide 30

Parameters

- Parameters dialog box
  - Model Parameters
    - automatically
  - User Parameters
    - manually defined

- Column names
  - Parameter Name
  - Units
  - Equation
  - Nominal Value
  - Tol
  - Model Value
  - Export Parameters Column
  - Comment
Slide 31

User Parameters

- **User Parameters**
  - Part files & assembly files
  - In one environment are not directly accessible in the other environment
    - linked parameter
  - Use any time a numeric value is required
  - Guidelines

Slide 32

Linked Parameters

- **Linked Parameters**
  - Multiple values & same parameters
  - Spreadsheet
    - Microsoft Excel
Slide 33

Linked Parameters

- Linked Parameters
  - Spreadsheet Embedded
    - no link – no updates
  - Spreadsheet Linked
    - will update
    - more than one can be linked
  - Guidelines
  - Edit

Slide 34

Complex Sketching and Constraining Techniques

Part Dimensional Tolerances
Part Dimensional Tolerances

- Part Dimensional Tolerances
  - Analyze - form, fit, and function
  - Dimensional tolerance condition
    - minimum, nominal, or maximum
  - Dimensions and features can have a tolerance applied
  - Tolerances
    - decimal-placed values—not fractions
  - Two methods
    - Standard Tolerances
    - Override Tolerances

Standard Tolerances

- Standard Tolerances
  - Three basic steps
  - Step 1
    - Define the Default Tolerance Style
      - linear and angular values
Slide 37

Standard Tolerances

- **Standard Tolerances**
  - **Step 2**
    - Setting the Default Decimal Precision and Display

Slide 38

Standard Tolerances

- **Standard Tolerances**
  - **Step 3**
    - Applying a Tolerance Condition
    - Tolerance dialog box
Override Tolerances

- **Override Tolerances**
  - Individual dimensions - upper and lower tolerances
  - Step 1 – Setting the Tolerance
  - Tolerance Types

Override Tolerances

- **Override Tolerances**
  - Tolerance condition to upper, nominal, or lower
  - Step 2 – Applying a Tolerance Condition
Slide 41

Tolerances

- Applying a Tolerance to a Feature’s Value
  - Tolerance dialog box
    - Evaluated Size
    - Change the appearance

Slide 42

Tolerances

- Annotating Tolerances in Drawings
  - Automatically displayed
  - Get Model Dimensions option
  - Overridden
Autodesk Inventor 6 Essentials Instructor Guide

Slide 43

Exercise 7-4

- Auto Dimension, Relationships and Parameters

Slide 44

Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create construction geometry</td>
<td>Change the line style to Construction from the Style area on the Standard toolbar</td>
<td><img src="image_url1" alt="Image" /></td>
</tr>
<tr>
<td>Create spline</td>
<td>Click the Spline tool from the Sketch Panel Bar</td>
<td><img src="image_url2" alt="Image" /></td>
</tr>
<tr>
<td>To pattern a sketch object</td>
<td>Click either the Rectangular Pattern or Circular Pattern tool from the Sketch Panel Bar</td>
<td><img src="image_url3" alt="Image" /></td>
</tr>
<tr>
<td>Share a sketch</td>
<td>Right-click on the sketch name in the Browser and select Share Sketch from the menu</td>
<td><img src="image_url4" alt="Image" /></td>
</tr>
<tr>
<td>Mirror a sketch</td>
<td>Click the Mirror tool on the Sketch Panel Bar</td>
<td><img src="image_url5" alt="Image" /></td>
</tr>
<tr>
<td>Temporarily slice away a portion of the model that obscures the plane</td>
<td>After making a sketch active, right-click and select Slice Graphics from the menu</td>
<td><img src="image_url6" alt="Image" /></td>
</tr>
<tr>
<td>Project selected edges, vertices, work features, curves, or silhouette edges</td>
<td>Click the Project Geometry tool from the Sketch Panel Bar</td>
<td><img src="image_url7" alt="Image" /></td>
</tr>
<tr>
<td>Sketch on a plane of another part</td>
<td>Click the 2D Sketch tool from the Standard toolbar and click on any planar face or plane of another part</td>
<td><img src="image_url8" alt="Image" /></td>
</tr>
<tr>
<td>Automatically create constraints and dimensions</td>
<td>Click the Auto Dimension tool from the Sketch Panel Bar</td>
<td><img src="image_url9" alt="Image" /></td>
</tr>
<tr>
<td>Create parameters</td>
<td>Click the Parameters tool from the Sketch, Part Features or the Assembly Panel Bar</td>
<td><img src="image_url10" alt="Image" /></td>
</tr>
<tr>
<td>To add tolerances to dimensions or a feature's value</td>
<td>Either set a standard tolerance or override a dimension or feature's value</td>
<td><img src="image_url11" alt="Image" /></td>
</tr>
</tbody>
</table>
Applying Your Skills

- Skill Exercise 7-1
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter seven.

1 True___ False___ Geometry that uses the construction style cannot be dimensioned to.
   
   False, Construction geometry can be constrained and dimensioned like normal geometry, but
   the construction geometry will not be seen in the part when the sketch is turned into a feature.

2 True___ False___ Splines cannot have geometric constraints applied between them and other geometry.
   
   False, Constraints can be added to any visible handlebars, curvature arc, or flat of any point on
   a spline. The following constraints can be added: concentric, equal, collinear, horizontal,
   perpendicular, parallel, tangent, and vertical.

3 True___ False___ Modifications to a shared sketch will update all the features that use that shared
   sketch.
   
   True

4 True___ False___ Slice Graphics will permanently slice away a portion of the model.
   
   False, The Slice Graphics option will temporarily slice away the portion of the model that obscures the
   plane on which you want to sketch. To restore the sliced graphics, right-click and select Slice Graphics,
   select Slice Graphics from the View menu, or click the Sketch or Return button from the Command Bar
   to end the sketch.

5 True___ False___ The Project tool can project vertices, work features, curves, or silhouette edges of
   another part in an assembly to the active sketch.
   
   True

6 True___ False___ If the Auto Dimension tool is used on the first sketch in the part, the sketch will be
   fully constrained.
   
   False, If you use the Auto Dimension tool on the first sketch in the part, two dimensions or
   constraints will be required to fully constrain the sketch. Use the Fix constraint to remove these
   two required dimensions.

7 True___ False___ When creating parameters in a spreadsheet, the data items must be in the following
   order: parameter name, value or equations, unit of measurement and, if needed, a comment.
   
   True

8 Explain how to suppress a patterned occurrence.
   
   To suppress a patterned occurrence, move the cursor over an occurrence in the pattern and right-click.
   A menu will appear, click Suppress Element(s) and then select the occurrence (s) that will be suppressed.

9 What is the difference between a Model Parameter and a User Parameter?
   
   • Model Parameters are automatically created and assigned a name when a sketch dimensions;
     feature parameters such as extrusion distance, draft angle, or coil pitch; and the offset, depth, or
     angle value of assembly constraint is created. Autodesk Inventor assigns a default name to each
     model parameter as it is created.
   • User Parameter are manually created in the Parameter dialog box.

10 Explain how to set all the values that have tolerances in a part to the same tolerance condition in a single
    operation.
    
    All the values for a part can also be reset to the same tolerance condition by clicking the upper, nominal,
    or lower tolerance conditions from the bottom right corner of the Parameters dialog box.
## Chapter Eight: Complex Part Modeling Techniques

### Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

### Topic: Complex part modeling techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Introduce complex part modeling techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Review chapter objectives</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Using open profiles</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Rib and web features</td>
<td>4</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Extrude feature termination options</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Emboss text features</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Instructor-led demo: emboss</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-2: Creating text and emboss features</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Sweep features</td>
<td>1</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-3: Creating sweep features</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Coil features</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Loft features</td>
<td>4</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Instructor-led demo: loft control</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>(2) Instructor-led demo: using guide rails</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-4: Creating loft features</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Part split and face split</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-5: Splitting a part</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Copying, reordering and mirroring features</td>
<td>1</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Suppressing features and feature rollback</td>
<td>1</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>File properties</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Center of gravity</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Override mass and volume properties</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chapter</td>
<td>Section</td>
<td>Hours</td>
<td>Notes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Visualization</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Exercise 8-6: Visualization</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Review Summary</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Applying Your Skills: Exercise 8-1</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total Hours</strong></td>
<td></td>
<td>3</td>
<td>54</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter eight: complex part modeling techniques
Using Open Profiles

- Sketch that does not form a closed area
- Only extrude tool can be used
- Extrude bi-directionally
  - positive or negative direction
  - fill direction
- Consumed inside or extend beyond the part

Technical Note
Using open profiles can make the part design more flexible for later revisions. Even though the outer geometry of the pocket may change drastically, the feature will continue to update (similar to a to next termination).
Exercise 8-1

- Extruding Open Profiles

Complex Part Modeling Techniques

Rib and Web Features
Technical Note
Design features to be robust (similar to open profiles). Extending the profile and using To Next terminations add flexibility into the part model and these features are less likely to fail or run into problems as the design is revised.
Slide 8

Rib and Web Features

- Rib and Web Features
  - Rib dialog box
  - Shape
    - Profile
    - Direction
  - Thickness
    - Edit Box
    - Flip Buttons
  - Extents
    - To Next
    - Finite
    - Extend Profile

Slide 9

Rib and Web Features

- Creating Rib and Web
- Rib Networks
  - Use multiple intersecting or nonintersecting sketch objects
  - Thickness is applied to all objects
  - Rib Network as a
    - Profile
    - Ribs
    - Webs
Slide 10

Exercise 8-2

- Creating Ribs and Webs

Slide 11

Complex Part Modeling Techniques

Extrude Feature Termination Options & Emboss Text Features
Chapter eight: complex part modeling techniques
**Instructor-led demo for emboss**

1. Open `Emboss.ipt`
2. Make the `Slot-Add/Remove` sketch visible
3. Click Emboss, then select the profile
4. Click Emboss/Engrave from Plane
5. Click Midplane as the direction, then click OK
6. Make the `Rectangle-Wrap` sketch visible
7. Click Emboss
8. Click Emboss from Face
9. Place a checkmark in Wrap to Face
10. Select the top face of the part, then click OK
11. Make the `Text-Cut/Join` sketch visible
12. Click Emboss
13. Select the text profile
14. Click Engrave from Face
15. Type 0.5 for Depth
16. Click the Top Face Color button, then select Black Chrome
17. Click OK
18. Close the file, do not save any changes

End of demonstration
Slide 14

Exercise 8-3

*Creating Text and Emboss Features*

Slide 15

Complex Part Modeling Techniques

Sweep Features
Slide 16

**Sweep Features**
- Sweep Features
  - Requires two unconsumed sketches
  - Sweep dialog box
    - Shape
      - Profile
      - Path
    - Operation buttons
    - More
      - Angle
  - Creating a Swept Feature

Slide 17

**Sweep Features**
- 3D Sketching
  - Overview
    - Defining a 3D path
    - Lip or routing
    - Work points
    - Model edges/vertices
  - 3D Sketch Environment
    - 2D & 3D curves
Sweep Features

- **3D Sketching**
  - **3D Path From Existing Geometry**
    - Define path
    - Use existing edges
  - Include Existing Geometry
    - Projecting part edges, vertices, and geometry
Technical Note

Multiple faces/surfaces may be used in the second selection set to create the 3D intersection curve.

3D Intersection Curves are similar in concept to projected loops within 2D sketches… If the geometry is modified that creates the curve, the intersection will be recomputed and update the 3D intersection curve.
Slide 20

Sweep Features

- **3D Sketching**
  - * Constructed Paths
    - Connecting
      - Work points
    - 3D line
    - Auto-Bend
      - Radius

Slide 21

Sweep Features

- **3D Sketching**
  - * Coincident Constraints
    - Endpoints of a line
    - Midpoints (midline) of a line
    - Shared lines
  - * Adding
    - Work point or vertex
Slide 22

Exercise 8-4

- Creating Sweep Features

Slide 23

Complex Part Modeling Techniques

Coil Features
Slide 24

Coil Features

- **Coil Features**
  - Helical, springs, or coil shapes
  - **Coil Shape**
    - Profile
    - Axis
    - Flip
    - Rotation
    - Operation
  - **Coil Size**
    - Type
    - Pitch
    - Revolution
    - Height
    - Taper

Slide 25

Coil Features

- **Coil Features**
  - **Coil Ends**
    - Start
    - End
    - Transition Angle
    - Flat Angle
  - **Using base & secondary feature**
Slide 26

Complex Part Modeling Techniques

Loft Features

- Blends a shape between two or more sections
- Complex shapes
  - Plastic or molded parts
- Sections
- Rails
- Points
- Curves

Slide 27

Loft Features

- Blends a shape between two or more sections
- Complex shapes
  - Plastic or molded parts
- Sections
- Rails
- Points
- Curves
Technical Note

The fewer elements used to create the loft sections the easier is will be to control the shape.

Stay away from over constrained situations (if start and end tangency exist, it is better to not use a rail even if it has those conditions)
Instructor-led demo for loft control

1. Open *LoftControl.ipt*
2. Click Loft
3. Click each section, starting on the left side
4. Click OK to create the loft feature
5. Rotate the model to show the *Free Condition* model
6. In the Browser, right-click the *Free Condition* model, then select Edit Feature
7. In Conditions, click *Sketch1*, then click the Direction Condition button.
8. In Weight type **20**
9. In Conditions, click *Sketch2*
10. Click the Direction Condition button, then In Weight type **10** and in Angle type **60**
11. Click OK
12. Rotate the model to review the effect of the edit
13. Close the file, do not save any changes

End of demonstration
Instructor-led demo for using guide rails

1. Open LoftGuideRails.ipt
2. The material for Loft1 is clear to make it easier to select the sections
3. Click Loft
4. Click the section, starting on the left side. You must select the smaller inside section. To do this, select the section edge then click to highlight the section profile.
5. In Sections, select Click to Add
6. Click the section at the top of the rail
7. Click the inside section on the right side of the model. A preview is shown.
8. Click OK
9. Rotate the model to review the loft
10. Close the file, do not save any changes

End of demonstration

Instructor-led demo for using guide rails

1. Open LoftMapPoints.ipt
2. Click Loft
3. Click the two sections, then click OK
4. The loft is incorrect. Right-click the Loft, then select Edit Feature
5. Click the Transition tab
6. Remove the checkmark from Automatic Mapping
7. In Point Set, select Set 1 noting the highlighted edge in the model
8. Click each set until you get to Set 4.
9. Remap the point to the top corner to the right (the end of Set 3)
10. Repeat for Set 5
11. Remap Set 6 and 7 to the top corner to the left (the end of Set 8)
12. Click OK. The loft is now correctly mapped.
13. Close the file, do not save any changes

End of demonstration
Exercise 8-5

- Creating Loft Features
Complex Part Modeling Techniques

Part Split and Face Split

- **Part Split and Face Split**
  - Method
    - Split Part
      - removing material
    - Split Face
  - Split dialog box
    - All
    - Select
    - Faces to Split
    - Split Tool
Exercise 8-6

- Splitting a Part

Complex Part Modeling Techniques

Copying, Reordering and Mirroring Features
Slide 35

**Copying, Reordering, and Mirroring Features**

- **Copying Features**
  - Dependent
  - Independent
  - Paste Features
  - Parameters
  - Pick Sketch Plane

Slide 36

**Reordering Features**

- **Browser**
  - Horizontal line
  - Drag

---

Chapter eight: complex part modeling techniques
Slide 37

Copying, Reordering, and Mirroring Features

- Mirroring Features
  - Features
    - dependent on the parent feature
  - Mirror Plane
  - Creation Method
  - Change or update

Slide 38

Exercise 8-7

- Copying, Reordering, and Mirroring Features
Slide 39

Complex Part Modeling Techniques

Suppressing Features & Feature Rollback

 Suppressing Features
- Temporarily turn off their display
- Simplify parts
- Increases system performance
- Unsuppress
- Parent – child relationships

Slide 40

Suppressing Features & Feature Rollback
Slide 41

Suppressing Features & Feature Rollback

- Feature Rollback
  - Roll back the design to an earlier state
  - Then place new features
  - Reorder

Slide 42

Exercise 8-8

- Feature Suppression and Rollback
Chapter eight: complex part modeling techniques

Slide 43

Complex Part Modeling Techniques

File Properties, Center of Gravity & Override Mass and Volume Properties

Slide 44

File Properties

- File Properties
  - iProperties
  - Properties dialog box
    - General
    - Summary
    - Project
    - Status
    - Custom
    - Save
    - Physical
Slide 45

Center of Gravity

- Center of Gravity
  - Part & Assembly
  - Representation
    - X, Y, and Z-axis arrows
  - Mass properties
  - Numeric value
  - Values are relative to the origin
  - Colorless - update

Slide 46

Override Mass and Volume Properties

- Override Mass and Volume Properties
  - Mass and volume values
  - Default & Overridden
  - Copy information into another application
Slide 47

Complex Part Modeling Techniques

Visualization

Visualization

- Distinguishing between different faces
- Colors, bitmaps, shadows, draft and tangencies
- Face Colors
  - Overrides
    - part color
    - feature color
    - face color

Slide 48
Slide 49

Visualization

- **Visualization**
  - Decals
  - Images In A Sketch
    - Bitmaps (raster file)
    - Microsoft Excel or Microsoft Word file

Slide 50

Visualization

- **Visualization**
  - Creating a Decal Feature
  - Shaded Display
  - Hidden Edge
    - Image
    - Face
    - Wrap
    - Chain Faces
Chapter eight: complex part modeling techniques

Slide 51

Visualization

- Visualization
  - Part Colors
- Texture Mapping
  - Define surface finishes
  - Texture .bmp file
  - Opacity Mapping
  - User-defined textures
  - Perforated textures

Slide 52

Visualization

- Visualization
  - Colors dialog box
    - Texture
      - % Scale
      - Rotation
  - Texture Chooser dialog box
    - Application Library
    - Project Library
Visualization

- Visualization
  - Texture Visibility
    - Show Reflections and Textures
  - Resolving the Texture
displayed with a special texture

Visualization

- Visualization
  - Part Materials
    - Physical properties and appearance
    - Physical tab
  - Shadows
    - No Shadow
    - Shadow
    - X-Ray Shadow
Slide 55

Visualization
- **Perspective View**
  - Perspective Camera
- Orthographic camera
  - Camera position
  - Lens focal length
- **Background Image**
  - Modeling environment
  - Bitmap

Slide 56

Exercise 8-9
- **Visualization**
**Slide 57**

### Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>To extrude an Open Profile</td>
<td>Click the Extrude tool, then click the Open Profile and click on the side of the part that will be filled in</td>
<td></td>
</tr>
<tr>
<td>To create a rib or web</td>
<td>Use the Rib tool and select an open profile</td>
<td></td>
</tr>
<tr>
<td>To change the extrusion termination</td>
<td>Start the Extrude tool, click the More tab, and then click the Minimum Solutions box</td>
<td></td>
</tr>
<tr>
<td>Place text on a sketch</td>
<td>Click the Create Text tool from the Sketch Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Embed text</td>
<td>Click the Embed tool from the Part Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a sweep feature</td>
<td>Click the Sweep tool from the Part Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a coil feature</td>
<td>Click the Coil tool from the Part Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a loft feature</td>
<td>Click the Loft tool from the Part Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Split a face or part</td>
<td>Click the Split tool from the Part Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Copy a feature</td>
<td>Right-click on a feature’s name in the Browser and click Copy from the menu and then Paste the feature</td>
<td></td>
</tr>
<tr>
<td>Reorder a feature</td>
<td>Click on the feature’s name in the Browser and, with the left mouse button depressed, drag the feature to the desired location</td>
<td></td>
</tr>
</tbody>
</table>

**Slide 58**

### Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mirror a feature</td>
<td>Click the Mirror Feature tool from the Features Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Suppress a feature</td>
<td>Right-click on the feature’s name in the Browser and click Suppress Feature from the menu</td>
<td></td>
</tr>
<tr>
<td>Rollback features</td>
<td>Click the End of Part marker in the Browser and, with the left mouse button depressed, drag the End of Part marker to the new location</td>
<td></td>
</tr>
<tr>
<td>Adjust a feature’s properties</td>
<td>Click the Properties option from the File menu</td>
<td></td>
</tr>
<tr>
<td>View the center of gravity of a part or assembly</td>
<td>Click Center of Gravity from the View menu</td>
<td></td>
</tr>
<tr>
<td>To create a decal feature</td>
<td>Click the Insert Image tool from the 2D Sketch Panel Bar and place an image, then click the Decal tool from the Features Panel Bar to make the image a decal feature</td>
<td></td>
</tr>
</tbody>
</table>
Slide 59

Applying Your Skills

• Skill Exercise 8-1
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter eight.

1 True___ False___ When creating a single rib or a web feature, only a closed profile can be selected as the profile.
False, A rib or web feature is defined by a open, unconsumed profile that is then refined using the options in the Rib dialog box.

2 True___ False___ Both the Extrude and Revolve tool can use the minimum or maximum extrusion solution.
False, The Extrude tool is the only tool that utilizes the minimum or maximum extrusion solution.

3 True___ False___ Embossed text can only be placed on a planar face.
False, A closed shape or text can be embossed or engraved onto a planar or curved face.

4 True___ False___ A sweep feature requires three unconsumed sketches.
False, A sweep feature requires two unconsumed sketches—a profile, and a path that the profile will follow.

5 True___ False___ A 3D curve can be created with a combination of both 2D and 3D curves.
True

6 Explain how to create a 3D path using geometry that intersects with a part.
- Create the intersecting features.
- Change to the 3D Sketch environment by clicking the 3D Sketch tool from the Standard toolbar under the 2D Sketch tool.
- Start the 3D Intersection tool from the 3D Sketch Panel Bar.
- The 3D Intersection Curve dialog box appears.
- Select the two intersecting features.
- Click the OK button and a 3D path will be created.

7 True___ False___ The easiest way to create a helical feature is to create a 3D path and then sweep a profile along this path.
False, Use the Coil tool.

8 True___ False___ You can control the twisting of profiles in a loft by defining point sets.
True, A point set is used to define how segments blend from one section to the segments of the section before and after it.

9 Explain how to save both halves of a part after splitting it.
To create a part with the other side removed, edit the split feature and redefine it to keep the other side, save the other half of the part to its own file using the Save As option.

10 True___ False___ Features can be copied between parts using the Copy Feature tool from the Features Panel Bar or Toolbar.
False,
- Right-click on a feature's name (in the Browser) that will be copied.
- Click Copy from the menu to copy the feature to the clipboard.
- Start the Paste command by doing one of the following:
  o Right-click and select Paste from the menu.
  o Click Paste from the Edit menu.
  o From the keyboard, press both the CTRL and V keys at the same time.

11 Explain the difference between suppressing and deleting a feature.
12 True ___ False ___ After mirroring a feature, the mirrored feature is independent on the parent feature.
   If the parent feature changes, the mirrored feature will not reflect this change.
   False, The mirrored feature(s) will be dependent on the parent feature—if the parent feature
   changes, the resulting mirror feature will also update to reflect the change.

13 Explain why you would want to override a part’s mass and volume properties.
   While designing, you may not always draw parts that are 100% complete; for example, you
   may model only the bounding area and critical features of a purchased part. You still want the
   mass and volume to be accurately represented in the Properties dialog box.

14 True ___ False ___ When creating a decal feature, the image must have started as a .jpg file.
   False, You can use a bitmap (raster file) or the contents of a Microsoft Excel or Microsoft Word file. The
   Microsoft Excel or Microsoft Word data is converted to a bitmap image.

15 True ___ False ___ After changing a part’s physical material properties, the part’s color in the graphics
   window will change to match the material.
   True
Chapter Nine: Complex Drawing View Creation and Editing

Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

Topic: Complex drawing view creation and editing

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Introduce complex drawing view creation and editing</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review chapter objectives</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Creating complex drawing views</td>
<td>11</td>
<td>4</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Drawing view options</td>
<td>4</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-1: Complex drawing view techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Managing sheets</td>
<td>4</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Dimensioning drawing views</td>
<td>1</td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: hole tables</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-2: Dimensioning drawing views</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Sketched objects</td>
<td>3</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Additional drawing tools</td>
<td>10</td>
<td>10</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Exercise 9-3: Annotations</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review Summary</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Applying Your Skills: Exercise 9-1</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td><strong>Total Hours</strong></td>
<td></td>
<td><strong>2</strong></td>
<td><strong>46</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Objectives

- **Chapter Objectives**
- Create auxiliary, section, broken and detail views
- Create break-out section views and perspective views
- Show and reference work features in drawing views
- Use sketches in drawing views
- Create dual, ordinate, and auto-baseline dimensions
- Move dimensions between views
- Create hole tables and revision block
- Create and use sketched symbols
- Describe tools associated with the Parts List dialog box

**Technical Note**

Describe the Design Support system throughout the lesson. Show the context sensitive help triggers both in the dialog boxes (reference information about the dialog box fields) and by selecting “How to” from the right-click menus when a command is active (procedural topics).
Slide 4

**Creating Drawing Views**

- **Auxiliary Views**
  - View that is projected perpendicular to a selected edge or line
  - Auxiliary View tool

**TRAINER NOTE**

This is a good place to show procedural help. (In the graphics window, right-click and select “How to.”)

**TECHNICAL INFORMATION**

An auxiliary view is dependent on and aligned to the parent view. Changes to the parent view are reflected in the auxiliary view.

You can move the view only within the defined alignment. To break the alignment select the view, right-click and then select Alignment>Break from the menu.
Creating Drawing Views

- Section Views
  - Created by sketching a line or multiple lines that will define the plane(s) that will be cut through a part or assembly
  - Section View tool

**TRAINER NOTE**

Show how to create the cutting line both ways: directly as part of the section view creation and defining the cutting line in a sketch associated to the parent view.

**TECHNICAL INFORMATION**

This view is the same as the auxiliary view.
Creating Drawing Views

- **Section Views**
  - Half Sections
  - Aligned Sections
  - Offset Sections
  - Modifying Hatch
    - Right-click > Modify Hatch

**TRAINER NOTE**
Note that default hatching and other attributes are determined by the active drafting standard.

Creating Drawing Views

- **Detail Views**
  - Drawing view that enlarges an area of an existing drawing view by a specified scale
  - Detail View tool

**TRAINER NOTE**
Note that a detail view is not aligned to the parent view.
Creating Drawing Views

» Broken Views
  » Removes a section or multiple sections from the middle of a long part and show just the ends
  » Broken View tool

TRAINER NOTE
This is a good place to show dialog box help. (Click the help button in the dialog box.)
Describe the descriptions for the orientation buttons.
Creating Drawing Views

- Break Out Views
  - Expose internal components or features
- Break Out View tool
  - Boundary Profile

**TRAINER NOTE**

This may be another place to show procedural help.

Briefly show how to create a sketch associated to a view. Describe 3 of the 4 methods of creating a breakout view require a profile defined in sketch associated to the view.
**TRAINEER NOTE**

Describe how the boundary must be defined on a sketch associated to the view before you can use this method. The boundary must be a closed profile.
Creating Drawing Views

- **Break Out Views**
  - **Depth Options**
    - From Point
    - To Sketch
    - To Hole

**TRAINER NOTE**

If the hole feature is hidden in the view, click the Show Hidden Edges button to temporarily show it.
Complex Drawing View Creation and Editing

Drawing View Options

- Perspective Views
  - Perspective views are used in providing a more natural or realistic view of an assembly or component

**TRAINER NOTE**
The perspective view is just one tool in the custom view window. Show how to use the tools to set up the view.
Drawing View Options

- Showing and Referencing Work Features
  - Center lines, datum definition for critical dimensions or features.
  - Show Contents > Get Work Features
    - Model Visibility is related to the initial display in a drawing view

**TRAINER NOTE**
Describe how you can include the work features when you place the view or add them later.

**TECHNICAL INFORMATION**

- A work feature will show in only one view on a drawing sheet. You must remove it from a view before you can add it to another view.
- For a work feature to show in a drawing view, its edge must be perpendicular to the view plane
- Set the display attributes for work features in the drafting standard for the drawing.
Drawing View Options

- **Using Sketches in Drawing Views**
  - Show Contents > Get Model Sketches
    - Simulate printed circuit board traces
    - Sharing a screen printing image on a component
    - Having a model sketch display in a created drawing view
  - Unconsumed sketches

**TRAINER NOTE**

Mention that you cannot edit model sketches from the drawing.
**Drawing View Options**

- **Draft Views**
  - Not created from a 3D part, but contains one or more associated 2D sketches
  - Can contain geometry, constraints, parametric dimensions, text, and other annotations
- **Draft View tool**

**TRAINER NOTE**

2D DWG data imported to a drawing placed in sketches associated to a draft view.

**Exercise 9-1**

- Complex Drawing View Techniques
Managing Sheets

Creating Multiple Sheets

- Adding Sheets
  - New Sheet tool
  - Insert > Sheet
  - Right-click drawing background > New Sheet
  - Right-click Browser > New Sheet

- Layouts
  - Copy/Paste
  - Right-click a format > New Sheet

**TRAINER NOTE**
Through this section, emphasize setting up sheets and sheet formats in the drawing templates so they are available to all new drawings.
Managing Sheets

Creating Sheet Formats

- Contains a predefined layout that can set the sheet size, border, title block, and views for a new sheet
  - Auxiliary, broken, detail, and section views cannot be predefined
- Create a sheet containing the elements you want to include
  - Right-click > Create Sheet Format

Copy views between sheets

- Use the same view in two different layouts
- Select the view, right-click > Copy
- Select destination, right-click > Paste
Managing Sheets

» Move views between sheets
  » Select the view(s) to move
  » Drag the selected views to the destination
  » The shortcut icon indicates that the base or dependent view for
    this view resides on another sheet

---

TRAINER NOTE
Throughout this section, emphasize that the default formatting for dimensions is
controlled by the dimension style and the default dimension style is set in the drafting
standard. Set up the dimension styles in the drawing templates.
TRAINER NOTE
Describe how the default dimension styles cannot be modified. Create a new style and make the desired changes to the new style.

Slide 27
Dimensioning Drawing Views

» Ordinate Dimensions
  » Indicates the location of a particular point along the X- or Y-axis from a common origin point
  » Ordinate Dimension Set tool
    » Place Origin
    » Options
    » Edit

AUTOCAD INVENTOR
www.autodesk.com

TRAINERS NOTE
Mention that a drawing view can contain only one origin indicator. Once it is placed it is used as the origin point for both ordinate dimensions and hole tables.
Dimensioning Drawing Views

- **Hole Tables**
  - Lists the location and size of all the holes (or just the selected holes) in a view
  - Hole Table tool
    - Hole Table – Selection
    - Hole Table – View
    - Hole Table – Selected Type

**Technical Note**
The location of holes in the hole table is relative to the point defined by the origin indicator.

Slide 31
Instructor-led demo for hole tables

1. Open *Hole Table.ipt*. Review the part.
2. Start a new drawing file using an ANSI (Metric) template
3. Create a Front View of the part
4. Switch to Drawing Annotations Panel
5. Click Hole Table - View
6. Select the view
7. Locate the datum on the lower left corner
8. Place the hole table in the drawing, then zoom into the table
9. In the Browser, right-click Hole Table, then select Edit > Options
10. In Hole Properties, select Combine Notes, then click OK. The size values are combined together.
11. In the Browser, right-click Hole Table, then select Edit > Options
12. In Hole Properties, deselect Combine Notes, then select Numbering, then click OK. The LOC values are now displayed as numbers.
13. In the Browser, right-click Hole Table, then select Edit > Options
14. In Hole Properties, deselect Numbering, and then select Rollup, then click OK. The first occurrence of each hole diameter is listed.
15. Close the file, do not save any changes

End of demonstration
Slide 32

Exercise 9-2

» Dimensioning Drawing Views

Slide 33

Sketched Objects

Creating and Using Sketched Symbols

TRAINER NOTE

Emphasize throughout this section that you can create sketched symbols in a template file so they are available to all new drawings.
Sketched Objects

- **Sketched Symbols**
  - Customized symbols that can be included on a drawing sheet
    - Safety symbols, Company logos
  - Creation
    - Right-click > Define New Symbol or Format > Define New Symbol
    - Create with sketch tools
    - Save Symbol

**TRAINER NOTE**

You can also import blocks from AutoCAD files as sketched symbols in a drawing or drawing template.
Sketched Objects

- Sketched Symbols
  - Inserting
    - Browser
      - Right-click > Insert on the sketched symbol in the Browser
    - Double-click the symbol icon

**TRAINER NOTE**

Describe that a symbol place with right-click>Insert is a fixed size symbol. It cannot be scaled or rotated after placement.

Sketched Objects

- Projecting Model Edges
  - Project edges of a model when creating a sketch as a child to a drawing view
    - Special effects such as crosshatching
  - Project Geometry tool
**TRAINER NOTE**

Mention that on-line help provides more information about parts lists.

---

Additional Drawing Tools

- **Linear Symmetric Arrowhead**
  - Select an edge of the object to be the first extension line location
  - Select another edge to be the second extension line location
  - Move the dimension to a desired location, right-click > Dimension Type > Linear Symmetric
Additional Drawing Tools

- Parts List Tools
  - Options
    - Edit Parts List.....
    - Compare
    - Column Chooser
    - Sort
    - Export
    - Heading
    - Renumber
    - Custom Parts
      - Above
      - Below

**TRAINER NOTE**

Emphasize that you can set up the parts list format in the drawing templates.

Slide 40
Additional Drawing Tools

- Parts List Tools
  - Format > Standards > Parts List tab

![Image of Additional Drawing Tools interface]
Additional Drawing Tools

» Using Part and Assembly Model Properties
  » Tools > Document Settings > Drawing
    » Custom Property Source
    » Copy Model Properties
    » Default Drawing File Name

TRAINER NOTE
Emphasize setting up iProperties in the template so that the work is done when you create a drawing and start placing views.

TECHNICAL INFORMATION
If you set Copy Model Properties in the template, the initial iProperties are set automatically in resultant drawings when you place the first drawing view.

If you specify a source file to reference for the custom iProperties, the selected properties are available in the dialog boxes as you define the parts list format or create title blocks, borders, and sketched symbols in the template. Resultant drawings then reference the data when the first drawing view is placed.

PROCESS
In your drawing template,

1. Open the Document Settings > Drawing tab and then check the Copy Model Properties box.
2. To reference a source file for custom properties, enter the name of the source file in the Custom Properties source box.
3. Click the Properties button to open the Properties Chooser and then select the properties to copy and the custom properties to reference.
**TRAINER NOTE**

Provide a reminder for students to not set Defer Update in the drawing template. It will prevent them from placing views in the resultant drawings.
Additional Drawing Tools

- **Revision Blocks**
  - Displays and keeps track of changes on the drawing
  - Revision Table tool
  - Double-click a cell in the table to edit its contents

**TRAINER NOTE**

Emphasize setting up the revision block format in the drawing template.

Additional Drawing Tools

- **Revision Blocks**
  - Modify revision block format
    - Right-click > Edit
Slide 46

Additional Drawing Tools

- Revision Tags
  - Tags an item on the drawing as revised
  - Revision Tag tool

Slide 47

Exercise 9-3

- Annotations
Slide 48

Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an auxiliary view</td>
<td>Click the Auxiliary View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a section view</td>
<td>Click the Section View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a detail view</td>
<td>Click the Detail View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a broken view</td>
<td>Click the Broken View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a break out view</td>
<td>Click the Break Out View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a flat view</td>
<td>Click the Flat View tool from the Drawing Views Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create hole dimensions</td>
<td>Create a new dimension style that includes alternate dimensions</td>
<td></td>
</tr>
<tr>
<td>Create ordinate dimensions</td>
<td>Click the Ordinate Dimension tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create ordinate dimension set</td>
<td>Click the Ordinate Dimension tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a hole table by selection</td>
<td>Click the Hole Table – Selection tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a hole table by view</td>
<td>Click the Hole Table – View tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a hole table by selected type</td>
<td>Click the Hole Table – Selected Tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a cross hatched symbol</td>
<td>Click on the Cross Hatched Symbol tool from the Browser</td>
<td></td>
</tr>
<tr>
<td>Create a revision block</td>
<td>Click the Revision Block tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create a revision tag</td>
<td>Click the Revision Tag tool from the Drawing Annotation Panel Bar</td>
<td></td>
</tr>
</tbody>
</table>

Slide 49

Applying Your Skills

» Skill Exercise 9-1
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter nine.

1. **True**  **False**  A broken view can only be derived from a base view.
   
   *FALSE. Broken views can be derived from orthographic and even section views.*

2. **True**  **False**  Auxiliary views typically show internal features of a part that have been cut.
   
   *FALSE. When showing internal features of a part that has been cut, a section view operation is performed.*

3. **True**  **False**  Imported AutoCAD 2D information is shared with Autodesk Inventor as a draft view.
   
   *TRUE*

4. **True**  **False**  A work feature will display in a drawing view even if the same work feature in the part model is turned off.
   
   *FALSE. Work features that are turned off in the model will not initially be displayed in the drawing view. You will have to manually turn on the visibility of the work feature through the Browser in order for it to be visible in the drawing view.*

5. Explain how to create a perspective drawing view.

   *Follow these steps for creating a perspective drawing view:*
   
   1. Click on the Base View button located in the Drawing Views Panel Bar.
   2. In the Drawing View dialog box, select the model to be used for the perspective view.
   3. Click on the Custom View button.
   4. When the Custom View window appears, use zoom, pan, or other viewing tools to position the view.
   5. Use the Camera Perspective tool to switch to perspective viewing.
   6. Click the check mark located in the Standard toolbar to accept the current view position.
   7. The perspective view is created when you return to the drawing.*

6. **True**  **False**  When using model sketches in drawing views, be sure the model sketch is completely constrained and dimensioned.
   
   *FALSE. The model sketch can have constraints and dimensions and still be displayed in a drawing view. The only requirement for displaying model sketches in drawing views is that the model sketch must be unconsumed.*

7. **True**  **False**  Ordinate dimensions are for reference only and cannot parametrically change the part’s size.
   
   *TRUE*

8. **True**  **False**  Hole tables can be created from extruded circles.
   
   *FALSE. A hole table is generated from holes created using the Hole tool.*
# Chapter Ten: Complex Assembly Modeling

## Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

### Day Two

**Topic: Complex assembly modeling**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Introduce complex assembly modeling</td>
<td>1.5</td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Design views</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Assembly Browser</td>
<td>6</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>iMates</td>
<td>10</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-1: Creating and using iMates</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Driving constraints</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-2: Driving constraints</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Constraint tools</td>
<td>3</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Replacing components</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Standard Parts Library</td>
<td>7</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-3: Fasteners and parts library</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Patterning components</td>
<td>8</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-4: Patterning components</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Assembly features</td>
<td>2.5</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-5: Assembly features</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2D design layout</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-6: 2D design layout</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Adaptive design techniques</td>
<td>10</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Exercise 10-7: Adaptive design techniques</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Review Summary</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Applying Your Skills: Exercise 10-1</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Total Minutes**: 5 70
Slide 1

Autodesk Inventor 6
Complex Assembly Modeling

Slide 2

Objectives

- Chapter Objectives
  - Create Design Views and iMates
  - Drive constraints to simulate motion in an assembly model
  - Replace a component with another component
  - Insert parts from the content library
  - Set up a new content library
  - Create rectangular and circular patterns of components
  - Apply assembly work features
  - Create assembly features
  - Create a 2D design layout
  - Create adaptive sketches and features
  - Create an adaptive subassembly
Complex Assembly Modeling

Design Views, Assembly Browser, iMates
### Design Views

- **Design Views**
  - Show the assembly in different states / viewing positions
  - Design Views store:
    - Component visibility
    - Component selection status (enabled or not enabled)
    - Color settings and style characteristics applied in the assembly
    - Zoom magnification
    - Viewing angle
    - Work feature display (Origin & User Defined)
  - Saved to an associated IDV file
    - Same name and directory as the assembly
    - Multiple Design Views can be saved in an IDV file

---

**Multi-User Tip** — The *.idv* file will contain a default design view for each person who opens an assembly file. This will allow different users to see the assembly as the last left it upon exit. Users may share each other’s design views however there is no “locking” scheme that prevents you from changing a design view that I created (since all design views are stored in one file).

**Performance Tip** — A very large assembly will perform more interactively (ie: faster) if only the parts you are working on (or need to interact with) are enabled. Saving a design view with a majority of the parts in the “not enabled” state will improve your interactive performance.
### Design Views

- **Creation**
  - Set the screen orientation & part visibility
  - **3 Methods:**
    - Click the Design Views tool
    - Click the arrow next to the Design Views icon (top of Browser)
    - View menu > Design Views
- **Design Views Dialog**
  - Save
  - Make Design View current
  - Delete

**Browser Tip** – Design views also store the expanded/collapsed state of the assembly browser.
Organizational Tip – The assembly browser shows the structure of the assembly. Components are shown in the chronological order in which they were placed. Prior to R6, you had the ability to reposition components within the browser sequence – this ability was removed with the addition of assembly features.

Components can be renamed in the browser. Doing so only changes the browser name of the component. This can be useful if you are required to use obscure file names and want to see more intelligible names in the browser.
Slide 7

**Technical Tip** - Components selected in the browser highlight in the graphics window. You can select a component in the browser and using the context menu FIND IN GRAPHICS is an option. The converse is also true – selecting a component in the graphics display will allow you to FIND IN BROWSER and doing so will adjust your browser to see the selected part. This can be useful when working with large assemblies.
Technical Note
Components can be dragged into existing subassemblies – dragging is the same as using the PROMOTE/DEMOTE command from the context menu which will create a new subassembly one level up or down within the hierarchy.
Slide 9

Assembly Browser

*Tools*

- **Assembly Restructure**
  - Right-click > Promote
    - Moves components from a subassembly to a parent assembly level
  - Assembly constraints are retained between restructured components that originate from the same assembly
  - Components moved to a different assembly lose assembly constraints with components outside the new assembly

Slide 10

Assembly Browser

*Tools*

- **Browser Filters**
  - Multiple filters that can be applied to the Browser

- **Position View**
  - Multiple filters that can be applied to the Browser
Slide 11

Assembly Browser

» Tools
  » Position View
    » Multiple filters that can be applied to the Browser
      » Modeling View
      » Position View

Slide 12

iMates

» iMates
  » Definition
    » An iMate holds information in the component or subassembly file on how the component or subassembly is to be assembled
    » iMates on both components must have the same name
      » Each component holds half of the iMate information
  » Creation
    » Tools > Create iMate
    » iMate tool > Part Features Panel Bar
Slide 13

iMates

» iMates

» Creation

» Create iMate dialog box

» Select the geometry to apply the constraint to

» iMate symbol is displayed on the component and in the Browser

Slide 14

iMates

» iMate Symbols

» Symbols show the type and state of the iMate

» iMates can be renamed

» iMates containing the same name can be automatically constrained
Slide 15

**iMates**

» **Using iMates**
  » Two Methods
    » Place Constraint tool
      » Select two iMate symbols on components
        (iMate type must match)
    » Place Component tool
      » Use iMate checkbox – matching iMates are consumed

Slide 16

**iMates**

» **Composite iMates**
  » Group multiple iMates into a single, composite iMate
    » Select multiple created iMates, right-click > Create Composite
Slide 17

<table>
<thead>
<tr>
<th>iMates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Composite iMates</strong></td>
</tr>
<tr>
<td><strong>Revisions</strong></td>
</tr>
<tr>
<td>• Rename the composite iMate or individual iMate members</td>
</tr>
<tr>
<td>• Drag and reorder individual iMate members</td>
</tr>
<tr>
<td>• Delete individual iMate members</td>
</tr>
<tr>
<td>• Remove individual iMate members from the composite</td>
</tr>
<tr>
<td>• Delete the entire composite</td>
</tr>
</tbody>
</table>

⚠️ You cannot reorder individual iMates into existing composite iMates

Slide 18

<table>
<thead>
<tr>
<th>iMates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Composite iMates</strong></td>
</tr>
<tr>
<td><strong>Using</strong></td>
</tr>
<tr>
<td>• Place Component &gt; Use iMate</td>
</tr>
<tr>
<td>• ALT + Drag</td>
</tr>
<tr>
<td><strong>Considerations</strong></td>
</tr>
<tr>
<td>• iMate type and values must match</td>
</tr>
<tr>
<td>• iMate names are used for pairing if multiple matches exist</td>
</tr>
<tr>
<td>• iMates are paired by sequence if multiple matches cannot be paired using names</td>
</tr>
</tbody>
</table>

**Technical Note**
The entire set of iMate members must match the same requirements to be a valid match.
Slide 19

**iMates**

- **Infer iMates**
  - Extract existing constraint data into an iMate
    - iMates or Composite iMates generated from constraints on one part or from all constraints of all occurrences of the selected part
    - Right-click a selected component > Infer iMates

Slide 20

**iMates**

- **ALT + Drag iMates**
  - Only matching iMate solutions are displayed
Slide 21

**iMates**

- **Visibility Controls**
  - Select a component with iMates in the Browser
  - Right-click > iMate Glyph Visibility

- When checked – iMate glyphs are displayed
- When unchecked – iMate glyphs are not displayed

Slide 22

**Exercise 10-1**

- Creating and Using iMates
Slide 23

Complex Assembly Modeling

Driving Constraints

Drive Constraint tool

Simulate motion

Right-click on a constraint in the Browser > Drive Constraint

Slide 24
Slide 25

Driving Constraints

> Drive Constraint tool
  > Dialog Box
    > Start, End, Pause
    > Play Controls
    > Record
    > More Button
      > Drive Adaptivity
      > Collision Detection
      > Increment
      > Repetitions
      > AVI Rate

Slide 26

Exercise 10-2

> Driving Constraints
Technical Note

Before you can drive constraints – you have to know about (and understand) constraints.

- Constraints provide the basic glue that holds an assembly together.
- Constraints can be lost when components are restructured.
- Constraints can be lost when parts are replaced.

For these reasons, it is important to understand iMates and the replacement of components which were created using SAVE COPY AS.
### Constraint Tools

#### Find Other Half
- Locates the matching part that participates in an assembly constraint
  - Right-click on a constraint in the Browser > Other Half
  - The Browser expands and highlights the second constraint

### Constraint Tools

#### Constraint Tool Tip
- Move the cursor over a constraint icon to display information about the constraint
  - Constraint name and Parameter name (offset/angle parameters)
  - Constrained components (two part names from the Browser)
  - Constraint solution and type
  - Constraint offset or angle value
Replacing Components

- Replace single or all occurrences of a component
  - Replace & Replace All tools

  Some assembly constraints may be lost when the shape of the component being replaced is different than the component replacing it.

Standard Parts Library

- Standard Parts Library
  - Screws, nuts, washers, & other standard components
    - Installed with a complete or custom installation
  - Library Browser Menu

Technical Note

The standard part library will create part files on disk – if no site-wide set-up has been specified, the created file will be saved in the workspace. Understanding projects, pathfiles and network installation is suggested.
Slide 32

Standard Parts Library

- Standard Parts Library
  - List View & Icon View
    - List View – Folder and title
    - Icon View

Slide 33

Standard Parts Library

- Standard Parts Library
  - Search
    - Simple
    - Advanced
Slide 34

Standard Parts Library

- Standard Parts Library
  - Favorites
    - Add to Favorites
  - History

Slide 35

Standard Parts Library

- Standard Parts Library
  - Configure
    - Select the libraries to work with
    - Only standard parts libraries chosen in the Configure server local dialog box are available to work with
Slide 36

**Standard Parts Library**

- **Placing Content**
  - Drag and drop content into the assembly
  - Eyedropper symbol appears when cursor placed over the image

Slide 37

**Standard Parts Library**

- **Replacing Content**
  - **Process**
    - Select the library component
    - Right-click > Find in Catalog
    - Locates the component page in the library
    - Select new sizes
    - Select function
      - Replace
      - Replace All
      - Place New
Slide 38

Exercise 10-3

» Fasteners and Parts Library

Slide 39

Complex Assembly Modeling

Pattern Components
Patterning Components

- Patterning Components
  - Places multiple occurrences of the same component or subassembly that match a feature pattern on another part
    - Pattern Component Tool
      - Associative tab (if the feature pattern changes, the components patterned will update)
    - Rectangular & Circular

Slide 41

Patterning Components

- Editing
  - Right-click in the Browser > Edit
  - Individual pattern occurrences can be suppressed
Slide 42

Autodesk Inventor 6 Essentials Instructor Guide

Slide 42

Patterning Components

- Patterning Components
  - Editing
    - Independent
      - Removes an individual occurrence of the pattern from the component pattern

Slide 43

Patterning Components

- Patterning Components
  - Deleting
    - Select the pattern, right-click > Delete
    - Tools > Application Options > Assembly
A component in an assembly can also be patterned in a rectangular or circular fashion.

- Pattern Component tool
- Rectangular

- Pattern Component tool
- Circular
Patterning Components

- Assembly Patterns
  - Replace
    - All occurrences in the assembly pattern can be replaced
    - Right-click an element > Replace Component

Exercise 10-4

- Patterning Components
Complex Assembly Modeling

Assembly Features

Assembly Work Features

- Help construct, position, and assembly components
- Associative to the parts they reference
  - Visibility
    - Global control
    - View > Object Visibility
slide 50

**Assembly Features**
- Assembly Features
  - Features defined in an assembly
  - Remove material from components only at the assembly level
    - Match-drilling operations
    - Post-weld machining operations
    - Cutting extrusions, Drilling holes, Chamfered edges

slide 51

**Assembly Features**
- Assembly Sketches
  - Sketch on a part’s face, work plane, or an assembly work plane
  - Geometry can be projected from various parts to the assembly sketch and constraints/dimensions added
Slide 52

Assembly Features

- Extrude, Hole, Chamfer, and work feature tools are available at the assembly level
- Do not affect the individual part files

Slide 53

Assembly Features

- End of Features marker
  - Separates assembly features from assembly components
  - Features affected by the assembly feature are found under the assembly feature
Slide 54

Assembly Features

» Assembly Features
  » Removing Participants
    » You can remove a part from being affected by the assembly feature
    » Right-click > Remove Participant

Slide 55

Assembly Features

» Assembly Features
  » Adding Participants
    » You can add a part to an assembly feature
    » Right-click the feature > Add Participant
Exercise 10-5

- Assembly Features

Slide 57

Complex Assembly Modeling

2D Design Layout
2D Design Layout

- 2D Design Layout
  - A 2D component can be used and constrained as a 3D part allowing you to verify function before committing to creating the form of parts

Slide 59

2D Design Layout

- 2D Design Layout
  - Assembly constraints can be added between 2D & 3D geometry
Slide 60

Exercise 10-6

» 2D Design Layout

Slide 61

Complex Assembly Modeling

Adaptive Design Techniques
 Adaptive Design Techniques

Definition
- Allows the size of a part to be determined by setting up a relationship between the part and another part in the assembly
  - Under-constrained sketches and features can adapt
  - Adaptivity relationship is acquired by applying constraints between an adaptive sketch or feature and another part
    - The sketch cannot be fully constrained
  - A part can only be adaptive in one assembly at a time
  - Only one occurrence of a part can be adaptive – other occurrences reflect the size of the adaptive part

Example
- Diameter of a pin from the size of a hole or vice-versa

Technical Note

CLARIFICATION - Adaptivity allows you to size and position part features which are underconstrained by using assembly constraints.
Both the part and the specific feature must be marked as being adaptive (doing so is possible via the browser).
Technical Note

This allows you to select the face of one part while modeling a feature in another part and to obtain an associative relationship to the projected edge geometry of the face (or edge). The relationship is marked as being adaptive in the browser because there is a constrained relationship created between two different parts.

CAUTION – Care should be exercised when creating cross-part relationships in this manner. While creation of a matching feature using this method is convenient, if the features are NOT going to change – creation of the adaptive link will impact performance. Subsequent drastic editing of the “parent” feature can cause the dependent feature to become sick and often yields assembly errors that novice users are unable to diagnose or fix.
Adaptive Design Techniques

- Sketches
  - Reference sketches can be used to create new parts that automatically update to match existing parts of an assembly
  - Use the Project Geometry tool > select face or other geometry on an existing part

Technical Note

To obtain this type of associative update requires that the checkbox shown in the previous slide is CHECKED.
Adaptive Design Techniques

» Sketches
  » Reference sketches can be used to create new parts
     that automatically update to match existing parts of an
     assembly
    » Use the project geometry to generate the new part

Adaptive Design Techniques

» Sketches
  » Adaptive Icon
    » Displayed in the Browser next to the sketch, the feature
       created from it, and the new part
    » The associative geometry projected onto the sketch is
displayed as a reference sketch
Adaptive Design Techniques

» Sketches
  » Controlling Reference Sketch Adaptivity
    » You can turn off the adaptivity of the reference sketch, the sketch, the feature created from the sketch, and the part
    » If the adaptivity of the part is turned off, adaptivity for all features is turned off

Adaptive Design Techniques

» Features
  » A part can resize to meet assembly constraints if one or more features of the part are defined as adaptive
    » Extrude
    » Revolve
    » Hole
      » Work Planes
  » Two Methods
    » Right-click > Adaptive
    » Right-click > Properties
    » Extrude
Slide 69

Adaptive Design Techniques

- **Features**
  - Revolve

- **Hole**

Slide 70

Adaptive Design Techniques

- **Subassembly**
  - Adaptive subassemblies control assembly constraints for moving parts inside any subassembly nesting level
  - Example
    - Air Cylinders
Exercise 10-7

Adaptive Design Techniques

Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create design views</td>
<td>Click the Design View button (Assembly Browser)</td>
<td></td>
</tr>
<tr>
<td>Create iMates</td>
<td>Click the iMate tool</td>
<td></td>
</tr>
<tr>
<td>Drive constraints</td>
<td>Right-click on an assembly constraint and choose Drive Constraints</td>
<td></td>
</tr>
<tr>
<td>Replace a component</td>
<td>Click the Replace Component tool</td>
<td></td>
</tr>
<tr>
<td>Insert components from the standard parts library</td>
<td>Click the arrow next to Model in the Browser and select Library</td>
<td></td>
</tr>
<tr>
<td>Create component patterns</td>
<td>Click the Component Pattern tool</td>
<td></td>
</tr>
<tr>
<td>Apply assembly work features</td>
<td>Click the Work Plane, Work Axis, or Work Point tools</td>
<td></td>
</tr>
<tr>
<td>Create assembly features</td>
<td>Click the Extrude, Hole, or Chamfer tools</td>
<td></td>
</tr>
<tr>
<td>Create adaptive sketches</td>
<td>When creating a part in place, projecting geometry by default will make the sketch geometry adaptive</td>
<td></td>
</tr>
</tbody>
</table>
Applying Your Skills

» Skill Exercise 10-1
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter ten.

1. True___ False___ A design view can control the display style (shaded or wireframe) of an assembly model.
   **FALSE. While design views can control component visibility, color settings, zoom magnification, and viewing angle, they do not control the display style of an assembly model. In other words, if you switch to wireframe, all design views are displayed in wireframe mode.**

2. True___ False___ iMates are created while inside of a part file.
   **TRUE**

3. True___ False___ The creation of an AVI file is one of the functions that can be accessed when driving constraints.
   **TRUE**

4. True___ False___ When replacing components in an assembly, assembly constraints will automatically be applied to the replacement component.
   **FALSE. When replacing components in an assembly, the new component will be placed in the same location as the original component. Assembly constraints may be retained. If the replacement part has a different shape than the original, some constraints may need to be reapplied in order to correctly position the replacement component.**

5. True___ False___ An entire set of pattern components can be turned off in a single operation.
   **TRUE.**

6. True___ False___ Of the total number of standard libraries supplied with Autodesk Inventor, you can narrow the number down to the most commonly used libraries for your applications.
   **TRUE**

7. True___ False___ Creating features in the context of an assembly will automatically update the individual parts that make up the assembly.
   **FALSE. When an assembly feature is created in the context of an assembly model, the individual parts that make up the assembly will not automatically update to reflect this created feature.**

8. True___ False___ A 2D design layout consists of a series of 2D sketches that are constrained to 3D parts in an assembly file.
   **TRUE.**

9. True___ False___ Hole features cannot be made adaptive.
   **FALSE. Hole features can be made adaptive.**

10. True___ False___ A sketch must be fully constrained to adapt.
    **FALSE. You usually underconstrain a sketch, which allows it to adapt in the context of an assembly model.**
Chapter Eleven: Sheet Metal Design

Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

Topic: Sheet metal design

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Introduce sheet metal design</td>
<td>1.5</td>
<td>1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>11</td>
<td>Review chapter eleven objectives</td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal fabrication</td>
<td>4</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal parts</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td>7</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-1: Sheet Metal part I</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td>7</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-2: Creating Hems</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet metal tools</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-3: Modifying sheet metal parts</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Sheet Metal tools</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-4: Cut across bend</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-5: Corner seams from shelled solids</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-6: Punch tool</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Detailing sheet metal designs</td>
<td>0.5</td>
<td>1</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>11</td>
<td>Exercise 11-7: Documenting sheet metal designs</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Applying Your Skills: Exercise 11-1</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total estimated hours</td>
<td>3</td>
<td>33</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Slide 1

Slide 2

Objectives

* Chapter Objectives
  * Start the Autodesk Inventor Sheet Metal environment
  * Modify settings for sheet metal design
  * Create sheet metal parts
  * Modify sheet metal parts to match design requirements
  * Create sheet metal flat patterns
  * Create drawing views of a sheet metal part
Sheet Metal Design

Sheet Metal Fabrication

» Sheet Metal Uses
  - Enclosures
  - Brackets
  - Structures or Frames
Slide 5

Sheet Metal Fabrication

- Bend Tables

\[ L = A + B - x \]

- L Unfolded Length
- A Length of folded face 1
- B Length of folded face 2
- x Adjustment from bend table

The measurements A and B are to the intersection of the extended outer faces on either side of the bend. This intersection is used when the angle of the bend is less than or equal to 90 degrees.

Slide 6

Sheet Metal Fabrication

- Bend Tables

\[ L = A + B - x \]

- L Unfolded Length
- A Length of folded face 1
- B Length of folded face 2
- x Adjustment from bend table

Use these measurements when the bend angle is greater than 90 degrees. The measurements are parallel to the face and tangent to the outer surface of the bend. The same formula is used to determine the unfolded length of the part.
Technical Note
Once you convert a part to sheet metal, you can't change it back.
Technical Note

Multiple K-factors and bend tables can be added to a style. One is the default method, but the others can be used on a per feature basis.
Technical Note

The ends of the bend are perpendicular to the bend centerline. The bend terminates at the first edge. Also bend and corner related parameters are default and most of them can be changed on a per feature basis.
Slide 11

Sheet Metal Tools

- Sheet Metal Styles
  - Corner Tab

- Round
- Square
- Tear
- Trim to Bend

Slide 12

Sheet Metal Tools

- Sheet Metal Face
  - Extrudes a closed profile a distance equal to the sheet metal thickness
    - Unfold Options
    - Relief Options
Sheet Metal Tools

- Contour Flange
  - Created from an open sketch profile
  - Bends are added at sharp intersections
Technical Note

The standard flange construction technique is to create the flange such that the virtual intersection of the flange and the face is located at the selected edge. This method is used primarily when designing in the context of an assembly. If you are working directly in the part file, the Bend Tangent to Side Face button (located under the Bend Radius field) creates the flange such that the bend is tangent to the edge of the sheet metal face.

Flange extends the full length of the selected edge, if not other options are selected at the “>>”. This is also valid for the features “Contour Flange” and “Hem”.

The “Bend Tangent to Side Face” button is important and useful, if the bend angle is greater than 90 degree.
Sheet Metal Tools

- **Hem**
  - Eliminate sharp edges
  - Strengthen an open edge of a face
  - Material is folded back over a face with a small gap

**Technical Note**
A gap is required because the kernel will merge faces that touch. A convenient way to specify a small gap is to create a User Parameter "o" and make it equal to a very small number (e.g., 0.00001)
Sheet Metal Tools

- **Fold**
  - Turns a flat pattern into a folded model
  - Add folds at sketched lines

**Technical Note**
The sketched line has to terminate on model edges.

Sheet Metal Tools

- **Bend**
  - Child objects of other features
    - When two faced connect
    - Connect disjointed face

**Technical Note**
The double bend options change depending on which edges are selected.
Sheet Metal Tools

- **Corner Seam**
  - Created when three faces meet
  - Create mitered gaps between coplanar faces

Sheet Metal Tools

- **Cut**
  - Sheet Metal implementation of Extrude > Cut
    - Distance of the cut is equal to the Thickness parameter
  - Project Flat Pattern
    - Cut Across Bend
Technical Note
These tools filter for sheet metal edges, which makes it easier to pick them.

Exercise 11-2
Creating Hems
Sheet Metal Design

Sheet Metal Tools

- PunchTool
  - Creates Cuts and 3D Deformations
    - Dimples
    - Louvers
  - Punch Folder
    - Applications Options > iFeature tab
Sheet Metal Tools

**Flat Pattern**
- Represents the starting point for sheet metal part manufacturing
- Creates a 3D model of the unfolded part
  - Displayed in a 2D drawing view
  - Flat Pattern - Browser

**Technical Note**
The flat pattern analyzer assumes that cuts go straight through the part. Features like chamfers and embosses will not appear correctly in the flat unless they are placed as iFeatures.
Sheet Metal Tools

» Common Tools

- Work Features, Holes, Catalog Tools, Mirror and Feature Patterns, Promote, Derived Component, Parameters, Create iMate
  » Similar to the part environment

Technical Note

These tools are Identical to the part environment.

The part modeling tools can be used to create sheet metal features. For example, a tube can be constructed by extruding a hollow cylinder and cutting a slot.

Exercise 11-3, 11-4, 11-5, 11-6

» Modifying sheet metal parts
» Cut across bend
» Corner seams from shelled solids
» Punch tool
Slide 29

Sheet Metal Design

Detailing Sheet Metal Designs

Slide 30

Detailing Sheet Metal Designs

- 3D Model and Flat Patterns
Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a sheet metal part</td>
<td>Select Sheet Metal from the Applications menu or use the Sheet Metal.ip template file</td>
<td></td>
</tr>
<tr>
<td>Edit sheet metal styles</td>
<td>Click the Styles tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a sheet metal face</td>
<td>Click the Face tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a sheet metal flange</td>
<td>Click the Flange tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a sheet metal bend</td>
<td>Click the Bend tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a sheet metal corner seam</td>
<td>Click the Corner Seam tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a sheet metal flat pattern model</td>
<td>Click the Flat Pattern tool in the Panel Bar or from the Sheet Metal Features toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a flat pattern drawing view</td>
<td>Click the Create View tool in the Panel Bar, or from the Drawing Management toolbar</td>
<td></td>
</tr>
</tbody>
</table>

Applying Your Skills

**Skill Exercise 11-1**
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter eleven.

1 The base feature of a sheet metal part is most often a:
   b). Face

2 What is the procedure to change the edges connected by a bend feature?
   c). Edit the bend and select the new edges.

3 Which tool would you use to create a full-length rectangular face off an existing face edge?
   a). Flange

4 What is required to update a flat pattern model?
   d). The flat pattern is updated automatically.

5 True___ False___ Sheet metal parts can contain features created with Autodesk Inventor modeling tools.
   True

6 True___ False___ Sheet Metal Style settings cannot be overridden; a new Style must be created for different settings.
   False, you can override specific settings of the current Sheet Metal Style on a per feature basis. Some of the settings that can be overridden are the Unfold Method, Bend Transition, Relief Shape, Relief Width, Relief Depth, Bend Radius, and Minimum Remnant.

7 True___ False___ During the creation of a sheet metal face, it can extend to meet another face and connect to it with a bend.
   True
Chapter Twelve: Surface Modeling

Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

Day Three

<table>
<thead>
<tr>
<th>Topic: Surface modeling</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduce surface modeling</td>
<td>0.5</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Review chapter twelve objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Creating surfaces</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Exercise 12-1: Importing surfaces</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Using surfaces</td>
<td>1</td>
<td>8</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Exercise 12-2: Using surfaces</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Face Analysis using display styles</td>
<td></td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Instructor-led demo: analyze draft (color)</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Instructor-led demo: analyze draft (zebra)</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Review Summary</td>
<td>1</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Applying Your Skills: Exercise 12-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td><strong>Total estimated hours</strong></td>
<td><strong>1.5</strong></td>
<td><strong>24</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter Objectives

- Create surfaces
- Import an IGES file that contains surfaces
- Promote and stitch surfaces from the construction environment
- Control the display of surfaces
- Use surfaces as a starting or terminating face
- Offset or add thickness to a surface
- Stitch multiple surfaces into a quilt
- Delete a face
- Replace a face on a part with a surface
- Analyze a part for draft and tangency conditions
Surface Modeling

Creating Surfaces

- Surface Modeling
  - Infinitely thin, define interior or exterior faces
  - Use profiles similar to creating a solid
    - Extrude
    - Loft
    - Revolve
    - Sweep
    - Offset (from the Thicken/Offset tool)
    - Promote
    - Derive Component
- Adding Features
  - Fillet
  - Chamfer
Slide 5

Creating Surfaces

- Importing Surfaces
  - IGES Files
    - Open tool
    - Options
    - Import
    - File Properties > Custom

Slide 6

Creating Surfaces

- Importing Surfaces
  - Construction Environment
    - When Auto Stitch and Promote is not used
    - Construction Folder
      - Group object
    - Editing data
      - Double-click the construction folder
      - Right-click > Edit Construction
Creating Surfaces

- Importing Surfaces
  - Promoting Surfaces
    - Promote tool
      - Converts imported data from construction environment to the part environment
      - Removed from group after promoted
    - Working with Group data

Slide 7

Creating Surfaces

- Importing Surfaces
  - Promoting Surfaces
    - Stitch and Gap Analysis
      - Stitch tool > Construction environment
        - Edges must be the same size and lie on top of each other
      - Analyze
        - Checks the surfaces for gaps
        - Erase
    - Surface or Solid

Slide 8
Creating Surfaces

- Importing Surfaces
  - Promoting Surfaces
    - Construction Group
      - Right-click > Promote
    - When the construction group is not active
    - Surface or Solid

Exercise 12-1

- Importing Surfaces
Surface Display
- Opaque or Translucent
  - Opaque > cannot see through the surface
  - Translucent > can see through the surface
  - Similar to work planes
- Tools > Application Options > Part tab
- Right-click the surface's name in the Browser
Slide 13

Using Surfaces

- **Terminations and Splits**
  - Start or terminating face for a feature
    - To or From To termination options
  - Split tool to split a face or part
    - Surface must touch or extend beyond the boundary of the shape it is cutting

Slide 14

Using Surfaces

- **Thickening and Offsetting Surfaces**
  - Thicken > gives thickness to a surface
    - Creates a solid feature
  - Offset > offsets a surface
    - Creates a surface
    - Parametrically linked to the original shape
    - Thicken/Offset tool
Slide 15

Using Surfaces

- Unified Shape Technology
  - Hybrid Modeling
    - Convert designs from parametric solid models to surface models and back to parametric solid models
    - Automatic conversion when particular tools are used
    - Icon in the Browser is changed

Slide 16

Using Surfaces

- Unified Shape Technology
  - Hybrid Modeling Tools
    - Stitching Surfaces
      - Join surfaces to form a quilt
Using Surfaces

- Unified Shape Technology
  - Hybrid Modeling Tools
    - Deleting Faces
      - Deletes individual faces, joined faces, or a quilt
      - Delete Face tool
    - Converts a solid model to a surface model
    - Heal option extends adjacent faces until they intersect
    - Healing maintains a solid model state

Technical Note

Healing to maintain a solid model state should not be used frequently. This should only be done in cases that are very difficult to achieve through feature modeling.
Technical Note

When using the replace face functionality, the faces immediately next to the face being replaced will be extended to intersect with the replacement face. These extended faces must fully intersect the replacement face.
Exercise 12-2

» Using Surfaces

Surface Modeling

Face Analysis Using Display Styles
Face Analysis Using Display Styles

» Draft
  - Displays the angle of part faces with respect to a selected pull direction

» Zebra
  - Displays the reflection of infinitely long parallel lines
  - Examine tangency between surfaces
    - Flat areas and Constant curvature

Technical Note
Checkboxes are not used anymore. Only one display style can be active at a time. This was done to remove user confusion.
Instructor-led demo for analyze draft (color)

1. Open AnalyzeDraft.ipt
2. On the Tools menu, click Analyze Faces
3. In Style, click Draft
4. Under Name, select Primary Draft from the list.
5. In Definition, place a checkmark in Gradient
6. Click OK. The color gradient is applied to the part.
7. Review the part
8. Close the file, do not save any changes

End of demonstration

Instructor-led demo for analyze draft (zebra)

1. Open AnalyzeZebra.ipt
2. On the Tools menu, click Analyze Faces
3. In Style, click Zebra
4. Under Name, select Primary Zebra from the list.
5. Click OK. The stripes are applied to the part.
6. Review the part
7. Close the file, do not save any changes

End of demonstration
Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a surface</td>
<td>Click the Stitch tool from the Part Features Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Import STL file</td>
<td>Click the Open box from the Standard folder and drag in STL file</td>
<td>(none)</td>
</tr>
<tr>
<td>Stitch surfaces from the construction environment</td>
<td>Click the Stitch tool from the Construction Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Promote a surface into another part environment</td>
<td>Click the Promote tool from the Part Features Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Replace a face(s) on a part</td>
<td>Click the Replace Face tool from the Part Features Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Analyze draft and tangency conditions</td>
<td>Click the Analyze Faces tool from the Standard toolbar</td>
<td>(none)</td>
</tr>
<tr>
<td>Offset a surface</td>
<td>Click the Thicken/Offset tool on the Features Panel Bar and select the solid output option</td>
<td>(none)</td>
</tr>
<tr>
<td>Add thickness to a surface and convert it to a solid model</td>
<td>Click the Thicken/Offset tool on the Features Panel Bar and select the solid output option</td>
<td>(none)</td>
</tr>
<tr>
<td>Select surfaces as a starting or terminating feature</td>
<td>Click the Select tool from the Features Panel Bar and select the surface</td>
<td>(none)</td>
</tr>
<tr>
<td>Right-click on the surface in the graphics window or on the surface's name in the Browser and choose Translucent</td>
<td>(none)</td>
<td></td>
</tr>
<tr>
<td>Stitch multiple surfaces into a quilt</td>
<td>Click the Stitch tool from the Part Features Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Stitch surfaces from the construction environment</td>
<td>Click the Stitch tool from the Construction Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Promote a part as surfaces into another part</td>
<td>Click the Promote tool from the Part Features Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Promote surfaces from the construction environment</td>
<td>Click the Promote tool from the Construction Panel Bar</td>
<td>(none)</td>
</tr>
<tr>
<td>Import an IGES file</td>
<td>Click the Open tool from the Standard toolbar and change the File of type to IGES or Select Import from the Insert menu</td>
<td>(none)</td>
</tr>
<tr>
<td>Create Surfaces Tool</td>
<td>(none)</td>
<td></td>
</tr>
</tbody>
</table>

Applying Your Skills

**Skill Exercise 12-1**
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter twelve.

1 True___ False___ Geometry that will be used to create a surface can have dimensions and geometric constraints applied to it.
   True

2 True___ False___ Surface will appear in a drawing view.
   False, Surfaces are not displayed in drawing views.

3 True___ False___ Fillets and chamfers can only be created between adjacent faces.
   True, The surfaces that are being filleted or chamfered must be continuous (no gap or overlap can exist between the edges of the two surfaces).

4 Explain how to convert surfaces from the construction environment to the part environment.
   - Start the Promote tool from the Construction Panel Bar.
   - In the Graphics windows select the surfaces that will be promoted. To select all the surfaces in the construction environment right-click in the graphics window and then click Select All from the menu.
   - In the Promoted dialog box check the Promote as surface option to promote the selected surfaces as surfaces to the part environment or uncheck the Promote as surface option to promote the selected surfaces as a base solid to the part environment.
   - Click the Promote button in the Promote dialog box to convert the selected surfaces or solids from the construction environment to the part environment.

5 True___ False___ When a surface’s display is changed to opaque it becomes a solid.
   False, Only the surface’s display is changed to opaque NOT its physical properties.

6 True___ False___ Multiple features can use the same surface as a starting or terminating face.
   True

7 True___ False___ Once a surface has been thickened, its profile cannot be edited.
   False, The thickened feature is parametrically linked to the originating sketch. If the original shape changes, the corresponding thickened feature will be updated to reflect the change.

8 True___ False___ A face can only be deleted from surface model, not a solid.
   False, A face can be deleted from a solid or a surface. If a face is deleted from a solid part and the heal option is not selected, the solid will be converted to surfaces.

9 True___ False___ When replacing faces on a part, those faces must be contiguous.
   False, The face(s) on the part that are being replaced can be contiguous or not, but must intersect the replacement surface(s) when extended.

10 True___ False___ Multiple parts can be analyzed for draft or curvature at the same time.
    False, Analysis can only be applied in the part environment and only for a single part at a time.
## Chapter Thirteen: Weldments

### Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

### Topic: Weldments

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Introduce weldments</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Review chapter thirteen objectives</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Welding basics</td>
<td></td>
<td>36</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Exercise 13-1: Creating weld beads and machining weldments</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Documenting weldments</td>
<td>0.5</td>
<td>11</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Exercise 13-2: Documenting weldments</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Applying Your Skills: Exercise 13-1</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Total estimated hours</strong></td>
<td><strong>1.5</strong></td>
<td><strong>53</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Slide 1

Slide 2

Objectives

- Chapter Objectives
  - Identify standard and detailed elements
  - Describe the difference between Arrow Side and Other Side
  - Control the size of a weld
  - Identify various weld symbols
  - Create a new weldment using Autodesk Inventor
  - Prepare component parts for welding by chamfering edges
  - Apply cosmetic and weld beads between component parts
  - Convert an existing assembly to a weldment
  - Document weldments in drawing mode
  - Add weldment annotations
Technical Note

CRITICALLY IMPORTANT!

The welding capabilities released in R6 represent a first step implementation. You will not be able to handle every case and some users may chose not to use the capability – preferring to continue documenting their welds via manual symbol placement on drawings.

The current implementation only provides for the basic creation of simple fillet weld beads.

Cosmetic weld creation allows a wider range of welding however it does not provide a physical feature that adds mass to the welded assembly.

Because more weld types are supported – the cosmetic weld bead workflow is the suggested workflow to use in this release.
Weldment Assemblies have a default material type. This material is used when physical beads are created. If you are welding steel, the material you use should be steel (not aluminum) if you want your calculated mass properties to be correct.

Autodesk Inventor ships with several materials defined for welds – users may create any material they need using the existing material creation capabilities.
Weldments

Overview
- Weld beads are possibly the most common assembly feature
  - Assemble components
    - Weld prep
    - Add cosmetic or fillet welds
    - Post weld machining operations

Technical Note

If you chose to view a weld bead as an assembly “feature” this is a true statement – most users view weldments as a completely different component.

Most users would say that “holes” are “…the most common assembly feature…”

While Inventor provides users with the ability to model weld preparation features – most users will not. Users who model “prep” will only be able to document the modeled prep within the context of a full weldment drawing and may decide that doing so is too time consuming.
Slide 5

Welding Basics

* Standard Weld Symbol
  * Elements
    * Reference line
    * Leader line w/ arrowhead
    * Tail
    * Special notes or welding processes

Slide 6

Welding Basics

* Standard Weld Symbol
  * Additional items can be added to the basic weld symbol
    * Finish Symbol
    * Contour Symbol
    * Groove Angle
    * Root Opening
    * Groove Weld Size
    * Preparation Depth
    * Reference Text or Specification
    * Process
    * Basic Weld Symbol Location
    * Number of Spot, Stud, or Projection Welds
Technical Note

Users outside of the United States who use ISO, DIN or BSI standards will be presented with the “arrow side” on the “bottom” of the weld symbol reference line (just like users of the ANSI standard) however the weld symbol created within the model will correctly show the arrow side on the top of the reference line.
Slide 8

Slide 9

Welding Basics

- Standard Weld Symbol
  - Arrow Side ~ Other Side Example

Welding Basics

- Standard Weld Symbol
  - Weld Size
    - Specify length and side of the weld
    - One numerical value = depth/side are the same value
  - Double weld with different sizes on each side
Slide 10

Welding Basics

» Standard Weld Symbol
  » Weld Size
    » Specify length and side of the weld
    » Different size legs

Technical Note
R6 CAVEAT - Inventor R6 does not provide a forward creation using the weld all around symbol – nor does it recover the circle symbol automatically onto the recovered symbol.
Slide 12

**Welding Basics**

* Basic Weld Types
  * Fillet
    * Most widely used
    * Left leg of symbol is always vertical
  * Groove
    * Seven types
      * Square
      * V
      * Bevel
      * J
      * U
      * Flare V
      * Flare Bevel
    * Numerical value to the left of the symbol = depth of the chamfer or groove
    * No value = size = thickness of the pieces being welded together

Technical Note
R6 CAVEAT – Inventor R6 can only physically create fillet welds between two components with no gap between the selected faces. Cosmetic weld definitions must be used for any other weld type in this release.

Slide 13

**Welding Basics**

<table>
<thead>
<tr>
<th>Groove Weld Types</th>
<th>Symbol</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Square</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>V</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>Bevel</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>J</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>U</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>Flare V</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
<tr>
<td>Flare Bevel</td>
<td><img src="Image" alt="Symbol" /></td>
<td><img src="Image" alt="Result" /></td>
</tr>
</tbody>
</table>
Welding Basics

Basic Weld Types

- Back or Backing Welds
  - Provides additional strength to a weld joint
  - Opposite side of the joint after the major weld is created

- Plug or Slot Welds
  - Join two overlapping pieces
  - Weld through a hole

- Surface Welds
  - Material is added or built up
  - Symbol is added to the bottom of the reference line
  - i.e., 3 mm of material is added to the surface

Spot Welds

- Fasten thin sheets of material
- Opposite side of the joint after the major weld is created
- Tails on the weld symbol are always present ~ specifies the process involved
  - RSW – Resistance Spot Weld
Slide 16

**Welding Basics**

- **Basic Weld Types**
  - **Seam Welds**
    - Similar to spot welds except it’s a continuous weld
    - Tails on the weld symbol are always present ~ specifies the process involved
    - RSEW – Resistance Seam Weld

Slide 17

**Welding Basics**

- **Basic Weld Types**
  - **Intermittent Welds**
    - Series of short welds
    - Length is added to the right of the weld symbol
    - Pitch is also added
      - Center-to-center distance between length increments
      - Separated from length by a dash
Slide 18

Welding Basics

» Basic Weld Types
  - Field Welds
    » Welds performed at a job site
    » Filled-in flag at the intersection of the symbol

Slide 19

Welding Basics

» Creating a New Weldment
  » IAM – Weldment templates
Slide 20

Welding Basics

« Converting an Existing Assembly
  « Applications > Weldment
    ♦ Cannot go back to a normal assembly file

Slide 21

Welding Basics

« Weldment Browser and Panel Bar
  « Three unique groups
    ♦ Preparations
    ♦ Welds
    ♦ Machining
      ♦ Activated by double-clicking the group name
      ♦ Associated tools become active
Technical Note

Welded assemblies can be created using two techniques:

1. Convert an existing assembly into a weldment
2. Begin building the weldment using one of the supplied welded assembly templates.
Slide 23

Welding Basics

- Weldment Creation Overview
  - Weldment Preparations
    - Only tools capable of creating weldment preparation features are available

Slide 24

Welding Basics

- Weldment Creation Overview
  - Welds
    - Weld tool and Work Feature tools are active
Slide 25

Welding Basics

> Weldment Creation Overview
  > Machining
    > Post-weld machining operations
    > Extrude, Hole, and Chamfer are available

Slide 26

Welding Basics

> Preparing Weldments
  > Remove material where welds will be applied
    > Activate Preparations
    > Create assembly features as needed
    > Exit Preparations
    > Weld Preparation by Extrusion
Slide 27

Welding Basics

- Preparing Weldments
  - Remove material where welds will be applied
    - Weld Preparation by Hole

Slide 28

Welding Basics

- Preparing Weldments
  - Remove material where welds will be applied
    - Weld Preparation by Chamfer
Slide 29

Welding Basics

» Creating Welds
  » Weld Feature dialog box
    » Weld tool
      » Type
        » Cosmetic/Fillet
      » Orientation
      » Main Area
        » Geometry Selectors
        » Other Size Controls
        » Weld Controls
        » Arrow Size Controls
        » Extents Control

Slide 30

Welding Basics

» Creating Welds
  » Weld Types
    » Cosmetic
      » Annotate edges, no weld bead geometry is created

Technical Note

Cosmetic welds are the suggested/preferred R6 workflow!
Slide 31

Welding Basics

- Creating Welds
  - Weld Types
    - Fillet
      - Create 3D geometry
      - Caterpillar texture map is applied to the faces of a weld

Slide 32

Welding Basics

- Cosmetic Welds
  - Default Type
    - Specify Weld Type
    - Arrow Side tab
      - Depth, Size, Intermittent specifications
Slide 33

Welding Basics

- **Cosmetic Welds**
  - **Default Type**
    - Specify Weld Type
    - Arrow Side tab
    - Depth, Size, Intermittent specifications

Slide 34

Welding Basics

- **Fillet Welds**
  - Only fillet welds are supported
  - Contribute to mass property calculations & interference analyses
Technical Note

Set selection filter to "Select Feature" to select the symbol.
Slide 37

Welding Basics

- **Weld Bead Size**
  - Measure Distance
    - Depth of the fillet weld must be less than or equal to the edge distance

Slide 38

Welding Basics

- **Weld Symbols**
  - Intermittent Weld Beads
    - Specify length of each segment and the distance between the center of each segment
    - Pitch or Spacing
Welding Basics

- Machining Weldments
  - Post-weld machining operations
    - Process
      - Activate the Machining group
      - Add the needed assembly features
      - Exit the Machining group
    - Typical Post-Weld operations
      - Extrude
      - Hole
      - Chamfer

Exercise 13-1

- Creating Weld Beads and Machining Weldments
Technical Note

IMPORTANT R6 CAVEAT - You can not create a drawing of a weldment that has been saved in the welding state – the assembly must be in the assembly state to allow the weldment drawing to be created!
Documenting Weldments

- **Documenting Weldments**
  - Add drawing views for one of four assembly states
    - Views of the assembly state show the model without defined weld preparations or welds.
    - Views of the preparations state show the model with defined weld preparations.
    - Views of the welds state show the model with weld preparations and welds.
    - Views of the machining state show the model with weld preparations, welds, and defined post-weld machining features.

---

**Technical Note**

By default, weldment assembly views are created using the “Machining” state – this allows the view to show the weld and any post-weld machining. Using any of the other view states limits what will be displayed in the drawing.
Slide 44

Documenting Weldments

- Add drawing views for one of four assembly states
- Samples

Slide 45

Documenting Weldments

- Add drawing views for one of four assembly states
- Samples

Assembly Only  Preparation
Weld Machining
Documenting Weldments

- Documenting Weldments
  - Using Model Weld Annotations
    - Associated to the model and update when changed
    - Model in the drawing view must be a weldment assembly.
    - To access the model weldment annotations in drawings, the weldment model must have the assembly state active.
    - Only solid body fillet welds will generate caterpillars and end treatments in the drawing. Cosmetic welds must be manually annotated.

Technical Note
Model weld symbols will appear in only one view on the sheet. You can drag them between views.
You can change the format and display attributes of model weld annotations, but you cannot change the values from the drawing.
Documenting Weldments

- Using Model Weld Annotations
  - Options > Model Weld Symbols
  - Right-click > Get Model Annotations > Get Weld Symbols

Documenting Weldments

- Drawing Weld Documentation
  - Manually addition of symbols
    - Weld Symbols
    - Caterpillars
    - End Treatments
  - Caterpillars
    - 2D symbols that represent the length, size, and direction of a weld
Slide 49

Documenting Weldments

- Documenting Weldments
  - Drawing Weld Documentation
    - End Treatments
      - End views of a weld

Slide 50

Documenting Weldments

- Documenting Weldments
  - Drawing Weld Documentation
    - 2D Weld Symbols
Documenting Weldments

- Drafting Standards for Welds
  - Format > Standards > Weld tab
  - Set defaults for adding 2D weld symbols, caterpillars, and end treatments

Exercise 13-2

- Documenting Weldments
Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new weldment</td>
<td>Click on the desired weldments icon from the list of templates</td>
<td></td>
</tr>
<tr>
<td>Prepare Weldments</td>
<td>Double-click on the Preparations group located in the Browser</td>
<td></td>
</tr>
<tr>
<td>Activate the Weld Feature dialog box</td>
<td>Click the Weld button located in the Weldment Features Panel Bar</td>
<td></td>
</tr>
<tr>
<td>Create Cosmetics Welds</td>
<td>Click the Cosmetic Weld button located in the Weld Feature dialog box</td>
<td></td>
</tr>
<tr>
<td>Create Weld Beads</td>
<td>Click the Weld Bead button located in the Weld Feature dialog box</td>
<td></td>
</tr>
<tr>
<td>Machine Weldments</td>
<td>Double-click on the Machining group located in the Browser</td>
<td></td>
</tr>
<tr>
<td>Convert an existing assembly to a weldment</td>
<td>Select the Weldment command found under the Applications menu</td>
<td></td>
</tr>
<tr>
<td>Create a caterpillar representation</td>
<td>Select the Caterpillar tool</td>
<td></td>
</tr>
<tr>
<td>Create an end treatment representation</td>
<td>Select the End Treatment tool</td>
<td></td>
</tr>
</tbody>
</table>

Applying Your Skills

» Skill Exercise 13-1
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter thirteen.

1 True ___ False ___ The vertical leg of a fillet weld symbol is always drawn to the left of the slanted side of the symbol.
   TRUE

2 True ___ False ___ The presence of a black flag on a weld symbol means to terminate all welding operations immediately.
   FALSE. The presence of a black flag on a weld symbol signifies a field weld.

3 True ___ False ___ When preparing a weldment, the following operations are supported: extrude-cut, hole, and chamfer.
   TRUE

4 True ___ False ___ To identify a weldment in Autodesk Inventor, look for the .wld file extension.
   FALSE. Weldments are considered a type of assembly model and are identified by the .iam file extension.

5 True ___ False ___ The three groups present in the Weldment Browser are Assembly, Preparations, and Machining.
   FALSE. The three groups present in the Weldment Browser are Preparations, Welds, and Machining.

6 True ___ False ___ The only weld type available when creating a cosmetic weld is fillet.
   FALSE. All weld types such as groove, spot, seam, backing, fillet, etc. are available when creating a cosmetic weld. The fillet weld is the only type available when creating a weld bead.

7 True ___ False ___ Cosmetic welds and weld beads are both available through the Weld Feature dialog box.
   TRUE

8 True ___ False ___ Typical operations supported when machining weldments include revolutions, lofts, extrusion joins, and fillets.
   FALSE. When performing machining operations on weldments, only chamfer, extrude-cut, and hole features can be created.

9 True ___ False ___ Assembly models created in previous versions of Autodesk Inventor cannot be converted to weldments.
   FALSE. Assembly models created in previous versions of Autodesk Inventor can be converted into a weldment.
Chapter Fourteen: Design Automation Techniques

Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills.

### Topic: Design automation techniques

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Introduce Design automation techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Review chapter fourteen objectives</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>iParts</td>
<td>2</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creating iParts</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Editing iParts</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creating iParts (additional author dialog)</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-1: Creating and placing iParts</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>iFeatures</td>
<td>0.5</td>
<td>11</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-2: Creating and placing iFeatures</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Derived parts</td>
<td>0.5</td>
<td>3</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Exercise 14-3: Creating a derived part</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Derived assemblies</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Customization</td>
<td>4</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Review Summary</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Applying Your Skills: Exercises 14-1, 14-2</td>
<td>1</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>2</td>
<td>42</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Slide 1

Autodesk Inventor 6 Essentials Instructor Guide

Chapter fourteen: design automation techniques
Speaker Notes: In this session we’ll review all of the Design Automation tools and techniques provided in Autodesk Inventor 6. Design Automation is the process of simplifying repetitive or frequently preformed tasks. For example, if a majority of your designs include brackets of the same basic shape and thickness but with a variety of “standard hole patterns. A useful automation project would be to create a typical bracket and hole chart and then to give users tools or spreadsheets that made it easy for them to select the appropriate hole pattern for the version of the bracket needed.

Autodesk Inventor includes several tools for Design Automation
- iParts – these are Parts or Part Factories with fixed values for all of the parameters (Standard iParts) or parameter values that can be set and selected by the user (custom iParts)
- iFeatures – similar to iParts but these are commonly used sets of features like slots or bosses or stiffeners (ribs).
- iFeatures also exist as:
  - Standard iFeatures with fixed values or
  - Table-driven iFeatures
• Derived parts are new parts which only exist at the combination of other parts or features. For example, think about the bracket example but now assume the bracket only exists as the combination of a “plate” and a hole pattern derived from the “mating part.” Derived parts allow users to explore design process states such as a machined part (the finished bracket) versus a casting blank (the original plate).

• User Interface Customization – User Interface customization is pretty easy to understand. Basically this includes the ability to customize the Autodesk Inventor user environment to focus on common tasks by making simple changes to the way they access the power of Autodesk Inventor via the menus.
**Speaker Notes:** With iParts you can store parameter and properties information and then retrieve that information to create unique part configurations. For example, a bushing part can be added to any Autodesk Inventor assembly in one of three possible configurations. With this example we control three basic characteristics of the bushing

- hole diameter
- materials type
- file name

We can edit these in any combination to create our final part.

iParts can be used in a couple of ways.

- Tabulated Parts – parts where you want to control a given parameter throughout a fixed series of values like having standard sizes for the diameter of this bushing.
- Family of Parts – or you can use iParts to create family of part tables.
Technical Note
Two stages for iParts. Creating them and inserting them into the assembly. This slides covers the high-level information on iParts.

Speaker Note: Discuss the two types of iParts that can be created and explain the differences of each type of iParts.
Creating iParts

Speaker notes: This slide reviews the tools for creating iParts. The Create iPart menu is found in the Tools Menu of the Autodesk Inventor standard toolbar. Selecting this option displays the iPart Author dialog menu. The iPart Author Dialog menu allows users to select the parameters that the user will be allowed to change. The items selected will be added automatically to the list of included parameters that make up the iPart factory.

Key hint: Use descriptive parameter names when you build the parameter tables for the iPart factory. That makes it easy for the subsequent users to understand their design modification choices. You also use the Author Dialog to define “keys” in your iPart factories. Keys are used to define a “version” of a part and the relationship of the parameters.

In the previous Busing iPart example, we had three parameters, diameter, materials name and file name. We could set the file name as our Primary and only key. That way when users selected a file name like “Big Copper” they would get the larger diameter bushing with the cooper material. If they selected “little Aluminum” they’d get the smaller diameter with the aluminum material.
Users can define up to 8 secondary keys. That would allow the user to select the material first and then select a list of sizes for the bushing in that material.

**Speaker Note:** Remind attendees that **Standard iParts** let users select from a pre-defined list of completed parts. Custom iParts give the user the ability to edit “specific” parameters of the part.
Slide 8

Creating iParts

iPart Author Dialog
- Custom iParts
  - Custom Parameter Column
  - Custom Parameter Cell
  - Specify a value for the parameter upon iPart placement

Speaker Note: Remind attendees that Standard iParts allows users the ability to select from a pre-defined list of completed parts. Custom iParts provides the ability to edit “specific” parameters of the part.

Slide 9

Creating iParts

iPart Author Dialog
- Click OK
  - The part is converted to an iPart Factory
  - Table saved as an embedded Microsoft Excel spreadsheet
  - Table icon is displayed in the Browser

Speaker Note: Once the author finishes defining the iPart, you simply click “Okay” in the Author Dialog box and the iPart creating process is complete. From that point on, the part is not an iPart Factory with an embedded MS Excel spreadsheet attached and a new Table icon in the part browser.
Slide 10

Editing iParts

- **Operations**
  - Delete table
  - Converts iPart back to a part
  - Modify parameters & properties
  - Add or Delete members
- **Edit Options**
  - Edit Table
  - Edit via Spreadsheet
    - Spreadsheet formulas, conditional statements, etc. are shown as red cells

Slide 11

Creating iParts

**Additional iPart Author Dialog**

- **Properties**
  - Add one or more file properties to the iPart
- **Suppression**
  - Select features to be suppressed within a member
- **iMates**
  - Include one or more iMates in the iPart
- **Threads**
  - Control Family, Designation, Class, Direction, and Pipe Dia.
- **Other**
  - Custom values (Color, Filename)
Creating iParts

Additional iPart Author Dialog Tabs
- Properties
  - Summary, project, and physical properties
  - Material Column Option

Suppression
- Suppress features of specific members
- Suppress or Compute in the table
Creating iParts

Additional iPart Author Dialog Tabs
- iMates
  - Use key assembly constraints when placing iParts
  - Define standard constraints for iParts
  - Define unique constraints for unique iPart members
  - Retain constraints during iPart replacement or changing iPart versions

Technical Note

**Note iMates** are also properties of an iPart. This allows users to control the way parts are inserted into assemblies and can be a tremendous time saver when users are exploring alternative design concepts (i.e.; swapping the copper bushing with the aluminum one to review costs and ensuring that the assembly will still move properly regardless of the bushing selected)
Slide 15

Creating iParts

Additional iPart Author Dialog Tabs

- Threads
  - Table-driven items for regular or tapered thread features
    - Designation > Size & Pitch
    - Direction > R or L
    - Pipe Diameter
    - Class
    - Family

Slide 16

Creating iParts

Additional iPart Author Dialog Tabs

- Other
  - Create custom table items
  - iPart member names
Slide 17

Creating iParts

Additional iPart Author Dialog Tabs

- Special Table Elements
  - File Name Column > Name of the iPart file
  - Display Style Column > Color of the iPart
  - Material Column > Material of the iPart
  - Only available for part properties and elements on the Other tab

Slide 18

Placing iParts

- Place Component tool
  - Standard & Custom iPart Placement dialog box
    - Custom – enter value from the custom column

  - Folder is created with same name as the iPart Factory
  - Folder is checked for existing members when placed
  - Folder is created in same location as the factory by default
Slide 19

Exercise 14-1

» Creating and Placing iParts

Slide 20

Design Automation Tools and Techniques

» iParts
  » Standard iParts
  » Custom iParts
» iFeatures
  » Standard iFeatures
  » Table-driven iFeatures
» Derived parts
» User Interface
  Customization

**Speaker Notes:** iFeatures work similar as iParts. iParts allow users to access a common part, with a common set of parameters and constraints and insert those into a variety of assemblies. iFeatures allows users to reuse a common set of features from a part in a variety of other parts.
Technical Note

Key characteristics of iFeatures.

- They are used to capture and communicate design intent,
  "this hole is not just this far from the edge, it’s also this far from the
  hole next to it…”

- They include placement information
  "always look for two, perpendicular edges when using this ‘L-
  shaped’ slot”

- They are represented by customer icons created by the author

- They are stored in the iFeature catalog. The catalog is a directory on your
  computer or the server and is accessed with the View Catalog tool. The
  tool opens with a Browser view of the catalog contents and works like the
  Open option in Windows Explorer.
Technical Note
Tools for creating iFeatures vary slightly from the tools for creating iParts. You access the iFeature menus in the same way, via the Tools menu in the Autodesk Inventor Standard Tool bar, but iFeatures are extracted from existing features in the model not Authored like iParts. From the iFeature dialog box, users have access all of the information needed to specific the iFeature.
Technical Note

Options available from the iFeature dialog include:

- Select – to define the iFeature desired
- Position – for positioning the iFeature in the model. Options are available to select the
  Name, Angle, and Move Coordinate System for the iFeature
- Size
- Name – allows the user to select a size based on a series of standard. For example, you might want your o-ring slots for carbon-carbon o-rings to have a slightly different shape that for your polymer o-rings. Selecting the right name will select the proper size and fit.
- Value – select a value for the size of the iFeature within the limits defined by the Author
- Precise Position
- Activate Sketch Edit Immediately allows the user to position the iFeature interactively
Slide 24

iFeatures

» iFeature Options
  » Tools > Application Options > iFeature tab

Slide 25

iFeatures

» Editing iFeatures
  » Open the .ide file in Autodesk Inventor
    » Edit iFeature
    » View Catalog
      » iFeature Author Table
    » Edit iFeature
      » Opens the Create iFeature dialog box
        » Cannot change parameters
        » Can modify size parameters and position geometry
          » Name
          » Value
          » Limit
          » Prompt
Slide 26

**iFeatures**

- **Table-Driven iFeatures**
  - Open the .ide file in Autodesk Inventor
  - iFeature Author Table
    - iFeatures behave similar to iParts
    - Main difference: No File Name, Display Style or Material column designations

Slide 27

**iFeatures**

- **Table-Driven iFeatures**
  - Inserting
    - Same as inserting typical iFeatures
    - Key parameters are a drop-down list
    - Custom parameters are specified in the dialog box
Slide 28

**iFeatures**

» Custom iFeature Icons
  » Browser Icons
    - Open the .ide file
    - File > Change Icon

Slide 29

**iFeatures**

» iFeature Placement Help
  » Embedding Objects
    - Insert > Object
Slide 30

iFeatures

- iFeature Placement Help
  - Embedding Objects
    - Insert > Object

Slide 31

Exercise 14-2

- Creating and Placing iFeatures
Technical Note
Derived parts are new parts which only exist at the combination of other parts or features. Think of the bracket example but now assume the bracket only exists as the combination of a “plate” and a hole pattern derived from the "mating part.” Derived parts allow users to explore design process states such as a machined part (the finished bracket) versus a casting blank (the original plate).

A derived part is used to:

• Capture Design Intent for any aspect of the part:
  o Entire Part
  o Part as a portion of an Assembly

A specific sketch or a surface that has a different use in the context of a derived part

• A Parameter
• Create new parts from the combination of existing parts or objects
• Explore design alternatives for different manufacturing processes
• Leverage sketches between parts in an assembly
• Simplify the representation of a part (i.e.; Derived parts can be used to represent a part as a box or a cylinder in an assembly drawing but as a detailed connecting rod or manifold in a part drawing)
Slide 33

Derived Parts

- Derived Component tool
  - Part Features Panel Bar
  - Derived Part Dialog
    - Symbols
    - Solid Body
    - Body as Work Surface
    - Sketches
    - Work Geometry
    - Surfaces
    - Exported Parameters
    - iMates
    - Scale
    - Mirror

Slide 34

Derived Parts

- Derived Component tool
  - Update
  - Break Link
Exercise 14-3

Creating a Derived Part

Derived Assemblies

Derived Component tool
- Select an assembly file instead of a part file to derive
- Derived Assembly Dialog
  - Click to Change
  - Keep seams between planar faces
Technical Note

User Interface Customization – User Interface customization is pretty easy to understand. Basically this includes the ability to customize the Autodesk Inventor user environment to focus on common tasks by making simple changes to the way they access the power of Autodesk inventor via the menus.
Technical Note

Users access the user interface customization tools from the Tools > customize menu in the Autodesk Inventor Standard tool bar or by right-clicking any tool bar in Autodesk inventor and selecting the “customize” option.
Technical Note

From within the customize menu, users have access to three modes or tabs. These include:

- Environments tab where authors or CAD managers determine where in the design process (part modeling or drawing mode etc…) the user interface changes need to occur
- Toolbars tab where CAD managers determine which tools bars will be edited. CAD managers can also specify access to additional information in the toolbars from this tab including
  - Access to Shortcut in tooltips
  - Viewing of commands in Expert Mode
  - Viewing of commands using Large Icons
  - Commands tab where the specific commands are selected, or removed. A powerful ease-of-use feature is the ability to simply drag and drop commands create customized tools bars in Autodesk Inventor.
Technical Note

Once new toolbars are defined, they can be

- Exported – for other users
- Imported – from a master set that might be created by a CAD manager for different types of users or tasks

You also have the tools to Reset All – to return to the default setting for Autodesk inventor.
### Summary

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an iPart</td>
<td>Select Create iPart from the Tools menu</td>
<td></td>
</tr>
<tr>
<td>Create a Custom iPart</td>
<td>Right-click a column in the iPart Author dialog and select Custom Parameter Column</td>
<td></td>
</tr>
<tr>
<td>Create an iFeature</td>
<td>Select Extract iFeature from the Tools menu</td>
<td></td>
</tr>
<tr>
<td>Insert an iFeature</td>
<td>Click Insert iFeature from the Part Features Panel Bar or toolbar</td>
<td></td>
</tr>
<tr>
<td>Create a table-driven iFeature</td>
<td>Click the iFeature Author Table tool from the iFeature Panel Bar or toolbar</td>
<td></td>
</tr>
<tr>
<td>Add a Custom iFeature Icon</td>
<td>Select Change Icon from the File menu when an iFeature is open in Autodesk Inventor</td>
<td></td>
</tr>
<tr>
<td>Modify a menu or toolbar</td>
<td>Click Customize from the Tools menu</td>
<td></td>
</tr>
</tbody>
</table>
## Applying Your Skills

- Skill Exercise 14-1, 14-2
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter fourteen.

1 Describe the difference between a Standard iPart and a Custom iPart.
   - **Standard iParts:**
     - Values cannot be modified
     - When placed, only predefined members can be selected
     - They cannot have features added to them
   - **Custom iParts:**
     - Unique values can be entered for certain variables
     - They can have features added to them
     - Require a unique name for each member

2 True___ False___ Multiple versions of an iPart can be placed in an assembly.
   True

3 True___ False___ When changes are made to an iPart Factory, the changes are automatically updated in iParts that have been placed in assemblies.
   False. To update the iParts in an assembly, open the assembly and click the Full Update tool from the Standard toolbar. iParts that need to be updated are marked with an update symbol in the Browser.

4 True___ False___ Standard iParts can have features added to them after they are placed in an assembly.
   False. Standard iParts can not be modified by adding features to them. The features that comprise Standard iParts are specified upon creation.

5 True___ False___ Named parameters are automatically added as Size Parameters during iFeature creation and cannot be removed.
   False. Named parameters are automatically added as size parameters, but can be removed from the parameters of the iFeature if desired.

6 Describe the process for including Placement Help with an iFeature.
   - Create an iFeature and the type of file you want to include as Placement Help.
   - Open the .ide file for editing.
   - Select Object from the Insert menu.
   - Select the file you want to use and click OK in the Insert Object dialog box.
   - Right-click the object in the Browser (located under the 3rd party icon) and select Placement Help from the menu.
   - Save the file.
   - When the iFeature is inserted into a part, click the blue information button located in the bottom left corner of the Insert iFeature dialog box to access the help file.

7 What happens when you create a table-driven iFeature and one of the original parameters contains a list of values for the parameter?
   A corresponding member is added to the iFeature table for each value that was specified in the List. If a parameter contained a list of three values for a dimension, there would be three individual rows created in the iFeature table.

8 How do you create a mirrored part file?
   - Create a new part file.
   - Exit the sketch environment if it is active.
   - Select the Derived Component tool.
   - Choose the part file that you want to mirror.
   - Select the Mirror part checkbox in the Derived Part dialog box.
   - Select a plane that you want to mirror the part about and click OK.
9 True ___ False ___ When creating a custom toolbar, the tools that are added must be from a single environment. You cannot include tools from multiple environments. 
   False. You can add tools from any environment available to a custom toolbar.

10 When can you import an .xml file containing customized settings?
   You can choose the import button from the Customization dialog box at anytime, but you are prompted for the file to import the next time that an Autodesk Inventor design session is started. The program must be closed and re-opened to import the .xml file that contains the customization settings.
Chapter Fifteen: Collaboration Techniques

Chapter Outline

This chapter provides instruction on the following topics and provides exercises for students to practice their skills

**Topic: Collaboration techniques**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Topic</th>
<th>Estimated Time (Hours)</th>
<th># of PowerPoint slides</th>
<th>Recommended</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Introduce collaboration techniques</td>
<td>1</td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review chapter fifteen objectives</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Engineer's notebook</td>
<td></td>
<td>7</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Multi-user environment</td>
<td></td>
<td>12</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>File Versions</td>
<td></td>
<td>2</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Instructor-led demo: file versions</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercises 15-1: File Versions</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Design Assistant</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-2: Using Design Assistant</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Online collaboration tools (Streamline, Team Web)</td>
<td></td>
<td>17</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Migrating Files</td>
<td></td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exchanging Model Data</td>
<td></td>
<td>13</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-3: Importing a DWG file</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Importing other file types</td>
<td></td>
<td>5</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-4: Importing IGES and STEP files</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Exercise 15-5: Base solids</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review Summary</td>
<td></td>
<td>1</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Applying Your Skills: Exercises 15-1 and 15-2</td>
<td></td>
<td>2</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Review Checking Your Skills answers at end of chapter</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Total** | 3 | 76 |
Training Objective: Help the attendees understand that we’ll go through all of the collaboration tools during this segment of the class.

Speaker Notes:

During this section we’ll review all of the collaboration tools provided in Autodesk Inventor. These include:

- The Engineer’s Notebook - document design intent
- Multi-User environment – Collaborate with other engineers all working on components of the same assembly
- Verify the status of design components and check files in or out for modification
- Design Assistant – manage file properties and make copies of designs
- Online Collaboration tools like Meet Now and Autodesk Streamline that allow your teams to interact in real-time
- Tools for migrating your existing Autodesk data. These include
  - Inventor Migration utility for upgrading Autodesk Inventor files
  - DWG Import and Export wizards for working with AutoCAD data and Legacy CAD translator Like Step and IGES - Import 3D files from other CAD systems and the Exchange Editor which allows Modify imported data from other CAD systems
Training Objective: Review the features and benefits of The Engineer’s Notebook.

Speaker Notes:
We’ll start our discussion on collaboration by reviewing the features of the Engineer’s Notebook.
Engineer’s Notebook

Add notes and other information to the design
- Attach to part, assembly, weldment, and sheet metal environments
- Associate questions and data to the components
- Record the design history
- Add external content (ie. Excel, FEA results, etc…)

**Trainer Note:** Provide the attendees with an overview of The Engineer’s notebook
**Trainer Note:** Describe how to open the Engineer’s Notebook and explain the components that are shown.

**Speaker Note:** “It’s simple to add notes to the any model by selecting the a sketch, feature part of assembly in the browser, then right-clicking and selecting the “create note” menu.

An Engineer’s Notebook entry includes a screen capture of the current graphics window and a text note. You’ll also get an entry in the assembly browser tree to show that we have a new note.
Trainer Notes: Use the next 4 slides to review the basic tools provided in The Engineer’s Notebook.

- Start with the Text creation tool which is used to add, format and edit text in the note. This tool works just like the text creation tool in the drawing manager.
- Review the view control tools which allow user to reposition the image inside the note. Notice that this tool includes the same pan/zoom/and rotate options found in the standard Inventor toolbar.
- There are also a series of context menus in the view control that allow you to delete the display of certain components in the note or to freeze them. This is helpful to eliminate extra geometry you might have in your note.
- The Next tool is the Notebook Panel with includes a series of menus. The first is the comment menu that lets you add text boxes in your note.
Trainer Notes: Review of the Engineer’s Notebook tools. Slide 2 of 4.

Describe where the Notebook panel bar, Comment, View and Arrow insert options are located.
Slide 8

**Engineer’s Notebook Tools**

- Previous and Next Note
  - Available when multiple notes exist in the file
- Adding Other Content
  - Insert > Object
  - Windows Object Linking and Embedding
- Managing Notes
  - Browser Menu
    - Sorting of notes
    - Folders

*Trainer Notes:*. Review of the Engineer’s Notebook tools. Slide 3 of 4.

Slide 9

**Engineer’s Notebook Tools**

- Note Display
  - Tooltip
    - Hover over a note symbol
    - Right-click > Edit
- Browser Filter
  - Hides Note Display
- Notebook Options
  - Tools > Application Options

Autodesk Inventor Collaboration Techniques

- The Engineer's Notebook
- Multi-User Environment
- File Versions
- Design Assistant
- Online Collaboration Tools
- Autodesk File Migration Tools
- Exchanging Model Data

**Trainer Note:** Review the features and benefits of the Multi-user environment.
Technical Note
The Multi-User Environment allows multiple engineers to collaborate on the same design or assembly and provides the controls to help manage the user interaction. There are three modes for Multi-user

1. off, no sharing of the models is allowed
2. Shared, where are the files are shared and accessed from a common network server
3. Semi-isolated where files are shared but the files that are being edited are downloaded to the users local environment.

The mode used is defined in the options of the Project file for each project. We’ll review each mode of the multi-User environment and the associated options.
The Multi-User Environment

**Shared Mode - Server Based (no local files)**
- All files accessed over the network
- Common project file
- Workgroup Search Paths, Library Search Paths, No Workspace

**Technical Note**
The “shared” mode is the simplest to understand and use.
The Project and all of the parts are hosted completely on the server. Everyone accesses the project:
- over the **network** and
- via a common **Project File**

This means everyone has access to the project with the same set of Workgroup search paths and Library search path and that no Workspace is defined for users.
Technical Note

In the Semi-isolated mode, users have access to a Common project file on the server where they access the parts.

They also set-up and have access to a Personal project file. This project file includes the Common Project file. With all of the Workgroup Search paths and libraries defined on the server, it also defines the local workspace for the individual user.

As you can see in this example, using the Semi-isolated mode, User 1 can design a part in the context of the assembly on his own machine and then save it into the vault on the server so that all users have access to the part.
Technical Note
The file Status Browser helps you manage and understand who is doing what with each file. Once you open the Status Browser you’ll get access to a the Check in & Check out tool. This is the little green box with the check mark in it. You also are provided with a visual update of the status of each file in the project by looking at the file status icon.
The Multi-User Environment

File Status

- Checked out to you – no saved edits
- Checked out to you – with saved changes
- File status is unknown (i.e., new file created)
- File is out of date with the most current version
- File check out by someone else – unavailable
- Check out cancelled, but not up to date with the old version on the server
- Available for check out
  - No icon – not in the project workgroup or workspace location
  - * - Changes have been made in memory that need to be saved (cannot be checked in in this state)

Technical Note

The file status icons give you lots of information about the file in the projects. For example, the status icons help you determine:

- Whether or not the file is checked out
- Whether you checked out the file or some one else
- Whether the file you want to access or are working on is the latest version on the server

You can see the other type of information you can get from the Status Browser.
The Multi-User Environment

Check Out Process
1. Select the sub-assembly
2. Right-Click to get the Check-out Panel
3. Select “Check out Tree”
4. Save Parts and Select “ok” in the Save Dialog box

Trainer Note: Describe the Check Out process.
1. Select a sub-assembly in the File Status Browser. First, notice that all of the status Icon in our Status Browser are currently empty. Remember this means that all of the parts are available for Check out.
2. Right-click on the selected sub-assembly to open the “Check out menu panel”
3. Select “Check Out Tree” and now you see that all of the icon have a little check mark in them. Remember, this means that the files are check out to you but that them have not been saved.

Trainer Note: Ask attendees what they think the boxes would show if we only selected the top option “Check Out”
Answer: only the first item would have the check in it.

Speaker Notes: Now let’s assume we edited the Parts “NewCrank & NewSpyde” and we want to save the edits. When you press Save, the “Save dialog box” appears asking us if we want save the changes. Click “Ok” (trainer note – use the mouse to click on the ok button on the dialog box” and then notice what happens to the File Status tree – The Status icons for the parts we saved and all of the “dependents” gets updated.
Speaker notes: We have several tools in the Multi-user environment that help us create new files in our assembly. These are:

- **Assembly Create In-Place** which allows users to build parts in the context of the other parts of the assembly
- **File New** which allow users to just create a new part and add it to the assembly
- And **Save Copy As** which allows us to save a copy of a part in our assembly (validate this with Travis)
- **Resolve Tool** is another useful tool that helps users resolve conflicts in the status of parts - we can review this in detail
Speaker Notes:
The resolve tool is used to help correct naming or file location problems. Typical problems might include discrepancies. Maybe the file is in the user workspace but not on the server or there are naming conflicts; maybe two users are creating parts with the same names.
The resolve tool helps you identify and correct these problems. Simply right click on the item with the “unknown” icon in the file status browser and then select the “resolve” option. In this example we can see that the problem is that the “unknown” part can not be found in any of the specified search paths.
After we correct the problem and continue with the Check out process, we’ll see the Status Icon update to the Checked out with changes Icon as shown here.
Technical Note

There are a few other Check out options.

1. Users can Cancel the check out process on any item by right-clicking on the option and then select the Cancel check out option. The status Browser updates and displays that the file is no longer check-out.

2. The other option is to edit the file and then cancel, if necessary, the edits. In this case, the Assembly needs to be refreshed to clear the changes that are in memory (indicated by the white checkmark / red background). To do this, the user must go to the view menu in the Autodesk inventor Standard tool bar and refresh the model.
The Multi-User Environment

- Steal Check Out
  - A user leaves the company or goes on vacation with files checked out.
  - Workspace files get lost due to deletion or a failed disk drive.
  - A network interruption occurs at an inopportune time

- Resolve tool
  - Steal Checkout
  - Cancel Checkout
The Multi-User Environment

Check In Process
- Context menu access – Check In or Check In Tree
- Skips all parts that are edited and not checked out

Technical Note

The process to check parts in works in much the same way as the check out process. Users access the Check In or Check in Tree options by right clicking on items in the browser and opening the context menus.

We will not go through all of the situations but in this example we can see that all files are checked-in except NewLiftRing. The Status Icon tells us that we can’t check in that part because it’s checked out to another user.
Trainer Note: Review the features and benefits of tracking file versions.
Autodesk Inventor also helps track file versions

When new files are save an older version is also saved in the “oldVersions” folder. In this Example new versions of the files “Rear Axle and Steering Wheel” are being saved and two older versions are being maintained in the oldversions folder. You can use the Open Oldversions Command to restore Oldversions of the file. This capability can be very useful if you want to experiment with a few concepts but want the flexibility to be able to go back and access the original or maybe the “as built” version of the design.
Instructor-led demo for file version

1. In the Single Versions Per File folder, open Single Version Per File
2. Add a **2 mm** fillet to the front edge, then save the file
3. In Windows Explorer, navigate to the Single Versions Per File folder
4. Note that there is now an Older Versions folder
5. Open the folder to display the filename and part file. Use Views > Thumbnails to demonstrate this
6. Repeat this for the current file Single Versions Per File folder
7. Repeat this workflow, adding a hole feature to the part and reviewing the entries in each folder
8. Close the file, do not save any changes

End of demonstration
The next collaboration tool we want to review is the Design Assistant. This tool helps users manage the relationship between Autodesk inventor files and other files that are in our designs.
Slide 26

Technical Note

With the Design Assistant users can

- View models
- Find related files
- Change or copy properties
- Create a copy of assemblies / components
- Maintain files and related documents
Speaker Notes: Users access the Design assistant in any of the following three ways.

- directly from the “file: menu inside of Autodesk Inventor
- by selecting on an Autodesk Inventor part in windows Explorer and then selecting the Design Assistant menu. This means that users don’t have to have Autodesk Inventor to find out where and how parts are used in their assemblies. Imagine how valuable this capability can be to your accounting or cost estimating people who just want to know how often a typical part is used in other designs.
- The Design assistant is also available to user from the Programs group.
Speaker Notes: There are three modes for the Design Assistant.

1. Properties mode which is used to review the file properties.
2. Preview mode where users can actually preview thumbnails of the files.
3. Manage mode that users access to help them control the structure and relationships of referenced files.

The modes are accessed by selecting the proper icon on the left side of the screen.
**Speaker notes:** In the Properties mode users have access to three specific tools or menus.

- The view menu that allows users to decide how the properties information is displayed either as a file hierarchy or spreadsheet.
- The tools menu provides users with the ability to create reports or copy design properties from file to file.
- The find tools which are some of the most powerful tools to help users locate Inventor files, determine where parts are associated files are used and look for strings inside of files – this could be used for example to search of specific part names or properties types.
Technical Note

The Preview mode is used to give users access to thumbnail previews of the selected files. This capability must be turned on by selecting the Save Preview Picture option located on the Save Tab of the file Properties menu.
Technical Note

The third mode of the Design Assistant is the Manage mode. This tool allows users to manage the relationship between Autodesk Inventor files and/or other files that are referenced like spreadsheets or FEA results or Text documents.

From the manage mode users can

- Search for files that reference a selected file
- Rename files
- Copy files and associate them with other files
- Replace a file

Basically, this is the set of tools that helps users define the relationship.
Exercise 15-2

Using the Design Assistant
**Trainer Note:** Review the features and benefits of the Design Collaboration tools in Autodesk Inventor.
Online Collaboration Tools

Meet Now
  • Share Applications
  • Chat Window
  • Whiteboard
  • File Transfer

Trainer Note: The Meet Now network tools set allows you to share your Autodesk Inventor desktop with other members of your team. Meet Now leverages the NetMeeting utilities of Microsoft Windows and gives users the tools to:

  • Share Applications
  • Chat Window
  • Whiteboard
  • File Transfer
Technical Note

The other collaboration tool is Autodesk Streamline, which is a web-based, hosted collaboration service. It provides a convenient and integrated way for companies to

- store their designs in centralized location as digital data.
- provide all types of users (engineers, purchasing agents, shop floor workers) with “personalized” views of the CAD files or whatever other information you want to share.

Autodesk Streamline has tools that make it easy for users to download and edit the documents. There are also integrated tools for adding comments and mark-ups to the files.

Key Point

The key advantage of Autodesk Streamline over other collaboration tools is that Autodesk Streamline allows engineers to create designs in Autodesk Inventor and attach all type of detailed information to that design. They then publish the rich digital design data as a package file in Autodesk Streamline which anyone with a web browser can access and review the data. The other advantage is that this approach allows the engineer to publish the data once and ensure that everyone with access is viewing the same materials.
Technical Note

Autodesk Streamline uses a unique “package file” concept as the primary tools for distribution of your design information. Users export package files directly from Autodesk Inventor. There’s a package file representation for all of the standard Autodesk Inventor files types including

- Assemblies
- Parts
- Drawings
- Autodesk Inventor Presentations
Slide 37

**Online Collaboration Tools**

**Autodesk Streamline**
- Assembly Packages
  - View and manipulate assembly models
  - Access properties of the files in the assembly
  - Create a markup of the assembly
  - Highlight and isolate components of the assembly
  - Change the visibility of components
  - View different types of information in the tree view
  - Measure components and distances between components
  - Print information
  - Display a Bill of Materials

**Trainer Note:** Next talk about the assembly package. Explain that the assembly package includes all of the part and structure information so users have access to more data about the design.

Slide 38

**Online Collaboration Tools**

**Autodesk Streamline**
- Part Packages
  - View and manipulate a part
  - Access properties of the part
  - Create a markup
  - Measure and dimension the part
  - Print information

**Trainer Note:** Start with a description of the part package. Discuss the tools available.
Online Collaboration Tools

Autodesk Streamline
- View tools
- Standard views
- Isolate
- Component Visibility
- Component Transparency

Trainer Notes:
Describe the View tools, which work with all of the Streamline packages but they are more interesting to show with the assembly package. Mention that since Autodesk Streamline provides a representation of both the model and the assembly structure, users have access to a tremendous amount of information about their models yet it’s easy for users to limit what they see or to change certain viewing attributes like transparency.

Show the example.
1. Click on “isolate” in the visibility menu. The image will update to the selected item.
2. Click on transparent in the visibility menu and the part will become transparent.

Use the rest of the time to review the four package files types. Autodesk Streamline exports package files for Parts, Assemblies, drawings and Autodesk Inventor Presentation files. Start with the assembly package information.
Online Collaboration Tools

**Autodesk Streamline**
- Assembly Packages
  - Tree View
  - Moving Components
  - Reset Position

---

**Trainer note:** This slide shows the tree view of the assembly package. In the Assembly structure mode users can look at the assembly structure in the same way they do in Autodesk Inventor.

1. Click on the Part count option and watch the Tree view update to give a view of the number of each part in the assembly.
2. Click again and explain that users can actually move components or sub-assemblies around in the tree structure. Notice how “Bushing” is now a sub-assembly under Drive Washer when in the original assembly structure (on the right) it was at the same assembly level.
3. Remind everyone that the users are doing this and review this information from a standard web browser. The reviewer does not need Autodesk Inventor to look at the model.
**Trainer note:** This shows the BOM view. Notice that Streamline captures whatever information the users put into the BOM, such as mass properties as displayed in this example. Explain that Streamline also allows users to access the design views defined by the engineer in Autodesk Inventor. This makes it easy to ensure that the Streamline users are viewing specific information that the engineers intended them to see.
Online Collaboration Tools

**Autodesk Streamline**
- Drawing Packages
  - View and manipulate a drawing
  - View the drawing and its associated sheets
  - Highlight edges of views and parts
  - Hide, show, and isolate views
  - Hide or show all annotations
  - Create a markup
  - Preview drawing sheets with thumbnail views
  - Print information

**Trainer Note:** Introduce the key feature of the Autodesk Streamline Drawing Package

Slide 43
Online Collaboration Tools

**Autodesk Streamline**
- Presentation Packages

---

**Trainer Note:** Show the Presentation package by presenting a demonstration of an AVI presentation.

---

**Online Collaboration Tools**

**Autodesk Streamline**
- Presentation Packages
  - Animate an entire assembly model
  - Animate and view specific tasks and sequences
  - View and manipulate the model
  - Turn predefined camera angles on or off
  - Measure the model
  - Create a markup
  - Print information
  - Identify individual components by name

---

**Trainer Note**

Describe the capabilities in the Presentation package. The Key features are the animation of specific tasks. This allows users to create process planning documents or assembly instructions within Autodesk Inventor and to view them with Autodesk Streamline.
**Online Collaboration Tools**

**Autodesk Streamline**
- Markups
  - Separate File (.smk)
  - 2D Drawings
  - 3D Models

**Trainer Note:**
Describe the process where Autodesk Streamline provides non-Autodesk Inventor users with access to design data and allows users to provide information back to the design engineer via mark-ups. Mark-ups are stored in a separate file on the Streamline project folder so all viewers have access. Users can create Autodesk Streamline mark-ups for 2D drawings as well as 3D models.
Slide 47

Online Collaboration Tools

Autodesk Streamline
- Properties
  - Available for assembly, subassembly, and part components
  - Optional export from Autodesk Inventor

Slide 48

Online Collaboration Tools

Autodesk Streamline
- iPublisher
  - Publish files to Streamline in the background
  - Separate downloadable installation
  - Shows status of connections and files that reside in the publishing queue

Trainer note:
Publishing Streamline packages is easy using the integrated iPublish tools available from the Autodesk.com/streamline web site. iPublish is set-up just like a printer queue that runs in the background.
Online Collaboration Tools

**Autodesk Streamline**
- iPublisher
  - Select a file to view the status of the files in the queue
    - Ready
    - Queued
    - Publishing
    - Publish Complete
    - Error
    - Cancelled
- Access
  - System Tray
  - Windows Explorer

Technical Note
The iPublish Status windows works just like a printer status window and provides users access to a variety of useful information.

Online Collaboration Tools

**Team Web**
- Opens an html file
  - Tools > Application Options > File tab
  - Can contain links to pages, I-drop files, calendars, etc.
Trainer Note: Review the features and benefits of Autodesk file Migration tools.
Technical Note
The Autodesk Inventor Migration utility has been updated with support for Autodesk Inventor 5 and 5.3
Technical Note

Just as with previous releases there are still four options on the Migration utility menu.

1. Instructions – which is an overview of how to use the Migration utility
2. Set Project – which allows you to define the project the updated files will be associated with
3. Open Options – which allow users to determine if they open entire directories, assemblies or just Selected files
4. Options – and the other options associated with migration
Autodesk Inventor Collaboration Techniques

- The Engineer’s Notebook
- Multi-User Environment
- File Versions
- Design Assistant
- Online Collaboration
- Autodesk File Migration
- Exchanging Model Data

Trainer Note: Review the features and benefits of Exchanging Model Data.

Exchanging Model Data

- Import & Export Translators
  - Link Autodesk Mechanical Desktop models
  - Import Autodesk Mechanical Desktop models
  - Read & Write SAT files, STEP files
- DWG Wizards (AutoCAD & Mechanical Desktop)
  - Import 2D drawing data
  - Autodesk Inventor drawings
  - Part feature sketches
  - Export Autodesk Inventor drawings & models
Slide 56

Exchanging Model Data

- Import AutoCAD & AutoCAD Mechanical Files
  - New Drawing
  - New Part
  - Title Block
  - Border
  - Symbol
- Import 2D geometry to an active sketch (part or drawing)

Slide 57

Exchanging Model Data

- Import Wizard
  - Opens first time you open a specific AutoCAD file type
  - Options button > Open dialog box
Exchanging Model Data

- Import Wizard
  - DWG File Import Options

Exchanging Model Data

- Import Wizard
  - Layer & Object Import Options
Slide 60

Exchanging Model Data

- Import Wizard
  - Import Destination Options

Slide 61

Exchanging Model Data

- Import Wizard
  - Import Destination Options ~ Advanced Options
Exchanging Model Data

- Import Wizard – MDT Files
  - Similar to the previous description except for MDT Model/Layout Import options page
Exchanging Model Data

- Linking MDT Files
  - Source files are maintained in Mechanical Desktop
  - Proxy files are created/used in Autodesk Inventor
  - Place Component tool links files instead of migrating/converting
  - Mechanical Desktop Path Wizard

**Trainer Note:** Describe the difference between “migrating” MDT files and “linking them. Linking allows users to leave the file in the original MDT format and to just access it from Inventor. This allows users to continue to work in a mixed environment if they have a need to maintain MDT files or associated drawings for other users or suppliers.
Slide 64

Exercise 15-3

- Importing a DWG File

Slide 65

Exchanging Model Data

- DWG Export
  - DWG Export Wizard (similar to Import wizard)

Technical Note

Note that the DWG Export wizard supports most versions of AutoCAD including AutoCAD 2000, AutoCAD 14 and AutoCAD 13
Slide 66

Exchanging Model Data

- DWG Export
  - Export Destination

Slide 67

Exchanging Model Data

- DWG Export
  - Advanced Options
Importing Other File Types

- SAT
  - Neutral file format based on ACIS
  - Imported as solid bodies or surface bodies
- STEP
  - Widely used to translate 3D models
- Pro/Engineer
  - Translate/import Pro/E files up to version 20
- IGES
  - Translate as surfaces or solid body (if 'water-tight' boundary is formed)
- Base Solids
  - Imported Solids
  - Promoted Surfaces

Technical Note
Describe the capabilities of the Explicit environment in Autodesk Inventor which allows users to edit (change the size or shape) non-parametric geometry that has been imported.
Slide 70

Importing Other File Types

- **Base Solids – Explicit Environment**
  - Move Face
    - Moves single/multiple faces a specified distance

Slide 71

Importing Other File Types

- **Base Solids - Explicit Environment**
  - Extend or Contract Body
    - Adds/Removes material from the base solid
Slide 72

Importing Other File Types

- **Base Solids - Explicit Environment**
  - Delete Faces
    - Select face > Delete key

- Work Features (Plane, Axis, Point)
- Toggle Precise UI

Slide 73

Exercise 15-4, 15-5

- Importing IGES and STEP files
- Base solids
Slide 74

**Summary**

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
<th>Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a note to a feature</td>
<td>Right-click on the feature in the Browser and select Create Note from the menu</td>
<td></td>
</tr>
<tr>
<td>Set up a Multi-User environment</td>
<td>Select Shared or Semi-isolated in the options of the Project File. Selecting Projects from the File menu can change the setting.</td>
<td></td>
</tr>
<tr>
<td>Open a previous version of a file</td>
<td>Use the Open tool and browse to an old version of the file. Located in the OldVersions sub-directory where the file is stored</td>
<td></td>
</tr>
<tr>
<td>Access the Design Assistant</td>
<td>Select Design Assistant from the File menu within Autodesk Inventor or right-click on a file in Windows Explorer and select Design Assistant from the menu</td>
<td></td>
</tr>
<tr>
<td>Import a DWG File</td>
<td>Select .dxf files from the Files of Type drop-down list in the Open dialog box and click the Options button to access the DWG import wizard</td>
<td></td>
</tr>
<tr>
<td>Export a DWG File</td>
<td>Select Save Copy As from the File menu in Autodesk Inventor, select .dxf from the Files of Type drop-down list, and then click the Options button to access DWG export wizard</td>
<td></td>
</tr>
<tr>
<td>Activate the explicit environment to edit a base solid</td>
<td>Double-click the Base Solid icon in the Browser or right-click the base solid and select Edit Solid from the menu</td>
<td></td>
</tr>
</tbody>
</table>

Slide 75

**Applying Your Skills**

**Skill Exercise 15-1**

[Image with a table and text content]
Applying Your Skills

» Skill Exercise 15-2
Answers to Checking Your Skills

Use this section to review the answers to the questions at the end of chapter fifteen.

1 True___ False___ An engineering note can be attached to a drawing file.
   False, The engineer’s notebook can be used in the part, assembly, weldment, and sheet metal environments.

2 To access the File Status Browser, the Multi-User setting in the Project File must be set to **Shared** or **Semi-Isolated**.

3 Explain a typical setup for the necessary project files to work in the semi-isolated environment.
   *Group Project File* is created and stored in a network location where other users can access it. It contains Workgroup Search Paths and Library Search Paths that will be used by everyone on the design team.
   
   *A Personal Project File* is created which contains the Group Project File as an Included File in the project and defines a personal Workspace.
   
   The Personal Project File makes it possible for any files being edited to be 'checked-out' and edited locally without other users seeing changes until the file is 'checked-in' to the workgroup. The Included File is set up so that everyone working on the project accesses the same files that are located on the server.

4 Describe the use of a workspace, local search path, workgroup search path, and library search path.
   - **Workspace** - Location where the files that you will be editing should be stored. This should be located on a local disk for best performance and robustness
   - **Local Search Path** - An extension of the workspace and can be used to store additional files that are kept separate from other users on the design team.
   - **Workgroup Search Path** - Location(s) where the majority of files that comprise the project are stored. Usually a server, and contains files that are shared by everyone on the design team.
   - **Library Search Path** - Location(s) where standard parts or files that do not need to be modified are stored. Usually on a server, and can be accessed by everyone on the design team.

5 True___ False___ When the active project contains an included file, you cannot add workgroup or library search paths to the active project.
   False, You can add search paths to a project file that contains an included file. The properties that are set in the included file cannot be modified from the project file that is referencing it.

6 True___ False___ You can use Design Assistant to copy file properties between unrelated files.
   True

7 True___ False___ With Design Assistant, you can copy parts but not assemblies.
   False, Design Assistant can be used to make copies of any type of Autodesk Inventor file.
8 True ___ False ___ You must be in the sketch environment to import a 2D AutoCAD file.
False. A 2D AutoCAD file can be imported into a number of various ‘locations’ in Autodesk Inventor. It can be brought into a drawing file, a 2D sketch in a part file, a title block, border, or sketched symbol.

9 True ___ False ___ Autodesk Inventor layers are translated to AutoCAD layers during export of an IDW file.
False. Autodesk Inventor does not use a layer scheme, but can export types of objects to specific AutoCAD layers.

10 True ___ False ___ Imported SAT files retain the creation history of the part.
False. SAT files are imported as a solid body and do not contain a feature history.